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You must install the software bundled on the Canon
Digital Camera Solution Disk before connecting the
camera to the computer.
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Canon

Install the software. Connect the camera
to the computer.
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Windows
Macintosh
e This guide explains how to install the software programs and
briefly introduces their functions and operating procedures. Exif Print

¢ Please read the software license agreement in this guide before

using the software. By using the software, you agree to be
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SAFETY PRECAUTIONS

The precautions noted within this guide are intended to instruct you in the safe and correct use of
the products and to prevent injuries or damage to yourself, other persons and property. Please
read and ensure that you understand them before proceeding to other sections of the guide.

AWarnings This symbol indicates topics that could lead to death or serious injury if
ignored or handled incorrectly.

AWarnings

¢ Do not play the supplied CD-ROM(s) in any CD player that does not support data CD-
ROMs. Playing the CD-ROM(s) in an audio CD player (music player) could damage the
speakers. It is also possible to suffer from hearing loss from listening with headphones to
the loud sounds of a CD-ROM played on a music CD player.

Disclaimer

¢ While every effort has been made to ensure that the information contained in this guide is
accurate and complete, no liability can be accepted for any errors or omissions. Canon
reserves the right to change the specifications of the hardware and software described
herein at any time without prior notice.

¢ No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval
system, or translated into any language in any form, by any means, without the prior
written permission of Canon.

e Canon makes no warranties for damages resulting from corrupted or lost data due to a
mistaken operation or malfunction of the camera, the software, the CompactFlash™ cards
(CF cards), personal computers, peripheral devices, or use of non-Canon CF cards.

Trademark Acknowledgments

e Canon and PowerShot are trademarks of Canon Inc.

e ArcSoft, the ArcSoft logo and ArcSoft PhotoStudio are trademarks or registered trademarks of
ArcSoft, Inc.

¢ Adobe is a trademark of Adobe Systems Incorporated.

e CompactFlash is a trademark of SanDisk Corporation.

¢ Macintosh, Mac OS and QuickTime are trademarks of Apple Computer Inc., registered in the
United States and other countries.

* Microsoft® and Windows® are either registered trademarks or trademarks of Microsoft
Corporation in the United States and/or other countries.

e Other names and products not mentioned above may be registered trademarks or trademarks of
their respective companies.

Copyright © 2004 Canon Inc. All rights reserved.

Canon Customer Support

For Canon Customer Support contacts, please see the Canon Limited Warranty supplied with
your camera.

ArcSoft Customer Support
North America

46601 Fremont Blvd., Fremont, CA 94538
Tel: (510) 440-9901 (Mon. - Fri., 8:30 AM - 5:30 PM PST)
E-mail: support@arcsoft.com

Other Regions
Please see the ArcSoft web site: http://www.arcsoft.com/maininternational.html.



READ CAREFULLY BEFORE USING

Canon Software License Agreement

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM IN THIS
BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT.

This is a license agreement (the “Agreement”) between you and Canon Inc. (“Canon”).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT USE THE
SOFTWARE PROGRAM ON THE CD-ROM (INCLUDING ALL SOUND AND IMAGE DATA) AND THE
USER MANUAL IN THIS BOX (COLLECTIVELY, THE “SOFTWARE") AND PROMPTLY RETURN THE
SOFTWARE TO YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and
conditions of this Agreement.

1.

LICENSE: Canon grants you the personal, non-exclusive right to use the SOFTWARE only on a single
computer. You may physically transfer the SOFTWARE from one computer to another provided that the
SOFTWARE is used on only one computer at a time. You shall not install or use the SOFTWARE on a
network, multiple CPU, multiple site arrangement, or any other hardware configuration where the
SOFTWARE is accessible to more than one CPU or to more than one user.

With respect to the sound and image data (“Data”) contained in the Software, which are to be
downloaded to the applicable Canon digital camera product, Canon grants you a personal, non-
exclusive license to use the Data on a single Canon digital camera product only.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE, ALTER,
MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART, EXCEPT AS
EXPRESSLY PROVIDED IN THIS AGREEMENT.

BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or copy the
SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer and retain the
original for back-up purposes. Any other copying of the SOFTWARE is a violation of this Agreement.
You must reproduce and include the copyright notice on the back-up copy.

SUPPORT AND UPDATES: Neither Canon, nor its subsidiaries, dealers or distributors will be responsible
for providing maintenance or support for use of the SOFTWARE. No updates, fixes or support will be
made available for the SOFTWARE.

LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose, maintain
and match the hardware and software components of your computer system. Thus Canon does not
guarantee uninterrupted service or correction of errors or that the functions or performance of the
SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED ON AN “AS IS” BASIS AND
WITHOUT WARRANTY OR CONDITION OF ANY KIND. The CD-ROM storing the SOFTWARE is
warranted only against defective material under normal use for a period of ninety (90) days after
purchase from an authorized Canon dealer as evidenced by your sales receipt. Your sole remedy for a
defective CD-ROM shall be replacement of the same without charge when returned by you at your
expense to your point of purchase and proven to be defective upon inspection. The Replacement CD-
ROM will be warranted for the remainder of the original ninety (90) day warranty period of the
defective CD-ROM. The limited warranty does not apply if the failure of the CD-ROM resulted from
accident, abuse or misapplication of the SOFTWARE and shall not extend to anyone other than the
original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON'S SUBSIDIARIES,
DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, OR CONDITIONS, EXPRESS OR
IMPLIED, INCLUDING ANY WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR
A PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS LIABLE
FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION, DIRECT,
CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF PROFITS, EXPENSE
OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE SOFTWARE OR THE USE
THEREOF.



NEITHER CANON, NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS SHALL
HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT BROUGHT BY A
THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF INFRINGES ANY
INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

SOME STATES, PROVINCES OR LEGAL JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF
IMPLIED WARRANTIES, OR THE LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR
CONSEQUENTIAL DAMAGES, OR PERSONAL INJURY OR DEATH RESULTING FROM NEGLIGENCE
ON THE PART OF THE SELLER, SO THE ABOVE DISCLAIMERS AND EXCLUSIONS MAY NOT APPLY
TO YOU.

TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until
expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may terminate this
Agreement by destroying the SOFTWARE. This Agreement will also terminate without notice to you if
you fail to comply with any of the terms of this Agreement and you must then promptly return the
SOFTWARE. In addition, Canon may enforce its other legal rights.

U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE:

The SOFTWARE is a “commercial item,” as that term is defined at 48 C.F.R. 2.101 (Oct 1995),
consisting of “commercial computer software” and “commercial computer software documentation,”
as such terms are used in 48 C.F.R. 12.212 (Sept 1995). Consistent with 48 C.F.R. 12.212 and 48 C.F.R.
227.7202-1 through 227.72024 (June 1995), all U.S. Government End Users shall acquire the
SOFTWARE with only those rights set forth herein. Manufacturer is Canon Inc./30-2, Shimomaruko 3-
chome, Ohta-ku, Tokyo 146-8501, Japan.

EXPORT RESTRICTIONS: You agree to comply with all export laws and restrictions and regulations of
the country involved, and not to export or re-export, directly or indirectly, the SOFTWARE in violation of
any such laws and restrictions and regulations, or without all necessary approvals.

SEVERABILITY:

In the event that any provision of this Agreement is declared or found to be illegal by any court or
tribunal of competent jurisdiction, such provision shall be null and void with respect to the jurisdiction
o}](‘fthat court or tribunal and all the remaining provisions of this Agreement shall remain in full force and
effect.

CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in the
United States of America shall be governed and construed in all respects in accordance with the laws
and regulations of the State of New York, without reference to choice of law principles. The terms of
this Agreement as it relates to purchases of the Software in Canada shall be governed by the laws of
the province of Ontario.

10.0WNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the
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SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of the
SOFTWARE s subject to the laws of the United States, and Canada, and other applicable copyright and
trademark laws, and nothing in this Agreement constitutes a waiver of the rights of Canon, its affiliated
corporations and third party licensors under such laws. You only own the CD-ROM media in which the
Software is stored. Except as expressly provided herein, no license or right, express or implied, is hereby
conveyed or granted by Canon to you for any intellectual property of Canon. Nothing contained in
Paragraph 1 shall be construed to give Canon any ownership rights in any images, graphics or textual
material that you save in connection with the Software.

You may not modify, remove or delete any or all copyright notices (i) which are contained in the
Software, including any copy thereof, and (ii) which are on the original CD-ROM and on the medium of
a back-up copy made pursuant to Section 2 above.

.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU HAVE

READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS TERMS AND
CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE COMPLETE AND EXCLUSIVE
STATEMENT OF AGREEMENT BETWEEN YOU AND CANON CONCERNING THE SUBJECT MATTER
HEREOF AND SUPERSEDES ALL PROPOSALS OR PRIOR AGREEMENTS, VERBAL OR WRITTEN,
AND ANY OTHER COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE SUBJECT
MATTER HEREOF. NO AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED
BY A DULY AUTHORIZED OFFICER OF CANON.
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Using the PDF Manuals

The following PDF-format manuals (hereafter PDF manuals) are provided to
explain the features and procedures for using ZoomBrowser EX and
ImageBrowser.

e ZoomBrowser EX Software User Guide (Windows)

*ImageBrowser Software User Guide (Macintosh)

s. If one of these applications is
computer, download it from the

Viewing PDF Manuals

Viewing Manuals Downloaded from a Website

These PDF-format manuals are available on the Canon website. Use your
browser program to download these manuals from the following URL:
http://web.canon.jp/Imaging/information-e.html




This chapter explains what you can accomplish using the camera with the software contained
on the Canon Digital Camera Solution Disk.
It also lists the computer system configurations required to use the software.

About this Guide
¢ The explanations in this guide are based on Windows XP and Mac OS X v10.3. If you are
using another version of these operating systems, the actual screen contents and
procedures may vary slightly from those shown.
¢ The following terms are used in this guide.
Mac OS X is used for Mac OS X (v10.1.5-v10.3)
Memory card is used for CF cards, SD cards, MultiMediaCards and PC cards.
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It's so Simple! Make Prints Right at Home
Like a Pro

(— Shoot the images _\

See your Camera User Guide for shooting instructions.

Install the software on the

(_ computer _\
2O

-

- ]

-

Windows (p. 10)
Macintosh (p. 49)

|

. _J

Just install the software once at the beginning.




r Connect the camera to the computer —\

I

’

Windows (p. 15)
Macintosh (p. 51)

(p. 95)

Print the images

°°==| —

Windows (p. 21)
Macintosh (p. 55)
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Unbounded Possibilities with Entertaining
Software

Print a Variety of Layouts

Print with the diverse layouts available in PhotoRecord (Windows) and ImageBrowser
(Macintosh). The examples shown are from PhotoRecord (Windows).

Make your own photo
album of precious
moments.

Qur Vacation

= | o

Beauliful sky, beautiful beach. Confirm all your images in one
S L T g f
glance with index (contact sheet)
printing.

Stitch a Panorama Together
Create a panoramic image from a series of images with PhotoStitch.




Send an Image as an E-mail Attachment

Attach an image to an e-mail message by starting your mail software from within
ZoomBrowser EX (Windows) or ImageBrowser (Macintosh).

Operate the Camera Shutter from the Computer

Release the camera’s shutter from the computer with ZoomBrowser EX (Windows) or
ImageBrowser (Macintosh). The recorded image is saved directly to your computer.

Edit a Movie

You can create and edit movies: link movies and stills that have been downloaded to your
computer, add background music, superimpose titles and other text, and apply various effects
to the movies.

Convert a RAW Image

RAW images are extremely high-quality images that are free of the resolution loss associated
with compression processing. However, since RAW images are a special type of image, it is
necessary to convert them into standard images. You can make fine adjustments to the image
quality and coloration when they are converted.
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System Requirements

Please install the software on a computer meeting the following minimum requirements.

0 e A CD-ROM drive is required to install the software.
o All procedures performed with a connection to a USB 2.0 compliant board are
not guaranteed.

¢ A sound card is required to play movie file audio tracks under Windows.

e With Windows, QuickTime 6.5 is required to play or edit movies or to save
images merged with PhotoStitch as QuickTime VR files. QuickTime is included
on the Canon Digital Camera Solution Disk.

e Macintosh software cannot be used on disks formatted in the UFS (Unix File
System) format.

(O

Windows 98 Second Edition (SE)

Windows Me

Windows 2000 Service Pack 4

Windows XP (including Service Pack 1 and Service Pack 2)

Computer Model

The above OS should be pre-installed on computers with built-in USB
ports.

CPU

Pentium 500 MHz or higher processor

Windows 98 SE/Windows Me: 128 MB or more
Windows 2000/Windows XP: 256 MB or more

USB
e Canon Utilities
- ZoomBrowser EX: 250 MB or more
(Including the PhotoRecord printing program)

- PhotoStitch: 40 MB or more
e Canon Camera TWAIN Driver: 25 MB or more
e Canon Camera WIA Driver: 25 MB or more
¢ ArcSoft PhotoStudio: 50 MB or more

1,024 x 768 pixels/High Color (16 bit) or better
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Mac OS X (v10.1.5-v10.3)

Computer Model

The above OS should be pre-installed on computers with built-in USB
ports.

CPU PowerPC G3/G4/G5
RAM 256 MB or more
Interface usB
Free Hard Disk e Canon Utilities
Space - ImageBrowser: 200 MB or more
- PhotoStitch: 40 MB or more
¢ ArcSoft PhotoStudio: 50 MB or more

Display

1,024 x 768 pixels/32,000 Colors or better




This chapter explains the basic procedures for installing the software and connecting the
camera to a computer. Read this material before you connect the camera to the computer.

Installing the Software and USB Driver

Start by installing the software from the Canon Digital Camera Solution Disk.

See ArcSoft PhotoStudio (p. 80) for details on how to install ArcSoft
PhotoStudio.

ltems to Prepare
e Your camera and computer

¢ Canon Digital Camera Solution Disk
e Interface cable supplied with the camera

Installation Procedures

1 Confirm that the camera is NOT connected to
the computer.
If it is, disconnect the cable. The software cannot
be properly installed if the camera is connected to
the computer at the start.

2 Close any programs that are running.



3  Place the Canon Digital Camera Solution Disk in the
computer’s CD-ROM drive.
If the installer panel does not appear automatically, use the
following procedures.

How to Display the Installer Panel
Use the following procedures to display the installer panel if it does not appear
automatically.

Windows XP

1. Select [My Computer] from the [Start] menu.
2. Right-click the CD-ROM icon and select [Open].
3. Double-click the [Setup.exe] & icon.

Windows 2000, Windows Me, Windows 98 SE

1. Double-click the [My Computer] icon on the desktop.

2. Right-click the CD-ROM icon and select [Open].

3. Double-click the [Setup.exe] & icon.

Some computers may not display the [.exe] file name extension as shown above.

4 Click the Digital Camera Software
[Install] button. Canon

- Digital Cameora Software
—4

CuackTime

Install

Exit

T
Installer Panel

Follow any instructions to restart your computer, if they appear. If the
following window appears, continue with the installation.
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5 Click [Next].

Canon Digital Camera Solution Disk [%]

‘Welcome to the InstaltSheeld Wizard for Solution
Dizk

i 1 oy
computer, To contirue, chick Mewt.

6 Select [Easy Installation] as the setup

type and click [Next]. seun
Chroume the sebup by that besl nats o needs.
Select [Custom Installation] to select — A
. o . . sy Iratallation Loy
programs individually for installation. e e Il o e
urfarier with the inptallshion.
! o — —_— —
< b4 Mot 3 Cancel

k

7 Click [Yes] if you agree to all of the terms of the software license agreement.

8 Review the installation settings and
click [Next].

Follow the onscreen instructions to

Canon Digital lution Disk.

Hlanl Comyiny Fibes
Pieview settings before copying fles.

Satup has encush i nath i i
proceed. Chorsr ony it chck Back. | you o saished vah tho actings. cick Mo bo Ewgi

opyng fer.

Cunrent Settingy:

estrtin ok,

C:\Progeam Files\Canon
Programs to be natsled:

The items displayed here differ according to. iy
the software installed. ZecnBiowees EX Phoiofecord




9 When the installation is over, select
[Yes, | want to restart my computer
now.] and click [Finish].

Canon Digital Camera Solution Disk

InstallShield Wizard Complete

The Install3hield \Wizard has successfull installed Solution
Disk. Eefore you can use the program, you must restart your
computer,

At this stage, do NOT remove the Solution
Disk from the CD-ROM drive yet.

@ Ves, | want bo restart my computer o,
" Mo, | will restart my computer later.

Click Finish o complete setup.

(;)

Users of Windows XP and Windows 2000 must log in as an Administrator
(computer system administrator) after restarting to carry out the
subsequent procedures.

10 Remove the disk from the CD-ROM drive when your
normal desktop screen appears after restarting.

This concludes the software installation.

Continue by connecting the camera to the computer so
that the USB driver can be utilized.

for use.

Iﬁl See Uninstalling the Software (p. 82) to delete the installed programs.

11 Attach the camera to the computer with the
interface cable and set the camera to the
correct mode for connecting.

Procedures for attaching the camera to the computer and placing the
camera in the correct mode for connecting vary between camera models.
See Information about Your Camera (p. 94).
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If the Digital Signature Not Found window e 1 |
appears, click [Yes].

The Microsolt digital signature affirms that software has
been tested with windows and that the software has not
been altered since it was tested

The saftware you are 2bout 1o install daes not contsin 2
Mictosoft digial signature. Therefore, thereis o
quarantes that this softwars works comectly with
Windaws.

HHHHEHIOH M

1f you wank to search for Microsalt diatall sianed
saftiare, visk the Wirdaws Lpdate Wb site at
hitp://inciovisupdate. miciosoft com ta ses f oneis
available.

Do youwart to confinue the installaion?

‘ ! Ho More Info

The USB driver will automatically finish installing onto the computer when you attach the
camera and open a connection.

Dialogs similar to the following will appear during this process (first time the camera is
connected to a computer only).

Windows XP
The dialog on the right will appear after a
few moments. _ ﬂ

) Found New Hardware |*| [Recycle Bin

Canon Digital Camera

Windows 2000/Windows Me/Windows 98 SE
Restart the computer according to the instructions if you are prompted to do so by a
message.

A dialog allowing you to set the default settings will display after installation. See Using
the Software on the Windows Platform — The Basics (p. 15) for the subsequent
procedures.

section (p. 86) if you are having problems installing the USB driver.

e See Uninstalling the USB Driver (p. 83) to delete the USB driver installed
with these procedures.

e See If You Were Using ZoomBrowser EX Version 2 or 3 (p. 93) if you
were previously using either version.

Iﬁl e See USB driver installation not proceeding well in the Troubleshooting

This concludes the software and USB driver installation and the procedures for connecting the
camera to the computer.
You may now download camera images to the computer (p. 15).



This chapter explains the procedures for using ZoomBrowser EX to download the camera's
images to the computer and print them.

Read this chapter after completing the preparations in the Using the Software on the Windows
Platform — Preparations section.

Downloading Images to the Computer

Begin by downloading the images to your computer. The downloading procedure is slightly
different according to whether you are using a camera to computer connection (see below) or
a memory card reader (p. 19).

You can also display an index of the camera or memory card images to check
them before downloading or to download them selectively. For instructions,
see Checking Images before Downloading (p. 34).

Camera to Computer Connection

1 Attach the supplied interface cable to the computer’s USB port and the camera’s
DIGITAL Terminal. Prepare the camera for communication with the computer.

Procedures for attaching the camera to the computer and placing it in
the correct mode for connecting vary between camera models. See
Information about Your Camera (p. 94).

The Camera Contro' W|ndOW Wl“ appear Cameralifindow, - Canon KOG |;\ |X\

Acquie Images | Set to Camera | Remote shooting |

Downloads using camera

Press the camera's bution
'

Downloads using computer

Starts to download images
F

Displays this screen when the camera is connected

Camera Control Window

Lets you select and download images
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Downloading Images to the Computer

First Time Camera is Connected to a Computer

Set the following settings the first time you connect the camera to the computer. These
procedures are not required from the second connection onward.

Select [Canon CameraWindow] when a
dialog (Events dialog) similar to that on
the right displays and click [OK].

Camera cornected

Your camera model name or "Canon
Camera" will appear here. Select the program ta launch far this actior:

i ) ~
Different programs may display <§ s
L NG
according to your computer setup.

72 Microsoft Scanner and Carnera Yizard
Diownload pictures from & camera o scanner

If this Events dialog does not appear, click the [Start] menu and select
0 [Programs] or [All Programs], followed by [Canon Utilities],
[CameraWindow] and [CameraWindow].

2 Download the Images' CameraWindow - Canon XXXKOCOMKEK E"§|@|
Download the images using the camera or i oo TGRS
the computer. By default, the downloaded

images are saved into the [My Pictures]
folder. 5w &0

Downloads using camera

Press the camera's button

Dovnlaads using computer

%@l Starts to download images

Lets you select and download images

Displays this screen when the camera is connected

You can adjust the settings, such as the type —1 £ Preferences.. |
of image downloaded and the destination

folder, by clicking [Preferences].




Using the Camera to Download Images (Direct Transfer Function)

¢ |f the conditions are right for the Direct Transfer function, the Direct
Transfer settings menu will appear in the LCD monitor. In addition, the

e See the Camera User Guide for instructions regarding Direct Transfer
settings and procedures.

yas (Print/Share) button will light if your camera is equipped with one.

Set the Direct Transfer settings on the
camera and press the Dz (Print/Share)
button or the [SET] button. Wi T

All Images...
New Images...

DPOF Trans. Images...
[ Select & Transfer...
& Wallpaper...

Using the Computer to Download Images
Click [Starts to download images].

Acaue Imaoes | Setlo Carnesn |, Rermode shwsive

Dowrikands g comers
oD

— Prass the camerm’s button
-

Downloads wng comguter |

[@ Starts 1o download images

i:‘_’j Lets you select and downlond images

[7] Displwys this scoeen when the camers Is connected

| Prefcrences... ] [ Finish

¢ By default, all the images that have yet to be downloaded will
download.
¢ To download images that have had their transfer settings set with the
camera, click [Preferences] and select [Images whose transfer settings
were specified with the camera] as the image type to be downloaded.

The downloaded images will be saved into folders according to their shooting date.

17




18 | Downloading Images to the Computer

By default, when downloading is complete,
the thumbnails (tiny versions) of the
downloaded images display in
ZoomBrowser EX's Main Window.

Thumbnail

Shows the folder where the images are
saved.

Next, print out the images (p. 21).
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Memory Card Connection
T insertthe memory card into the reader.

Use a separately sold card adapter (PCMCIA adapter) if required.
See the manual for the memory card reader for its connection and handling instructions.

\ (2) Insert the loaded adapter into the slot.

(1) Place the memory card in an adapter if required.

The card adapter and memory card shape may vary according
to the type of memory card your camera utilizes.

2 Select [VieW/DOWnload |mageS USing T iew a slideshow of the images
Canon Ca meraWi ndOW] When the [ uzing Windows Picture and Fax Viewer
i i i 7% Copy pictures to a fold h
dialog to the right appears and click - btk

[OK].
The Camera Control Window will display.

Wiew Images
Uzing ZoomErowser B

v
|| Abways do the selected agl
‘ 0k , Cancel

S

If the dialog above fails to appear, click the [Start] menu and select
[Programs] or [All Programs], followed by [Canon Utilities],
[CameraWindow] and [CameraWindow], and proceed to Step 3.

3 dick [Starts to download images].

CameraWindow - H:ADCIM

Acquie Images | Set to Memory Card

Starts to download images

NG

Lets you select and download images

(B |

)
You can adjust the settings, such as the type__

of image downloaded and the destination
folder, by clicking [Preferences].
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¢ By default, all the images that have yet to be downloaded will
download to the [My Pictures] folder.

*To download images that have had their transfer settings set with the
camera, click [Preferences] and select [Images whose transfer settings
were specified with the camera] as the image type to be downloaded.

®See Memory Card Folder Structure (p. 85) for information about
memory card folder structures and file names.

The downloaded images are saved into folders according to the shooting date.

By default, when the download is complete, the thumbnails (tiny versions) of the
downloaded images display in ZoomBrowser EX's main window.

Next, print out the images (p. 21).
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Printing Images

This section explains the basic procedures for using PhotoRecord, a printing utility program. See
the program’s [Help] menu for more details.

* Movies cannot be printed.

*\With images shot by Exif 2.2 (called Exif Print) compatible cameras, shooting
information such as the shooting settings and mode can be included with
the images. This data is then used to correct the images to obtain better
prints.

¢ PhotoRecord automatically carries out image correction (by default) both
with images shot with Exif 2.2 compatible cameras and other images,
yielding high-quality prints.

1 dik [Print] in the Main Window, followed by [Layout Print].

BT ZoomBroveser EX - D:\Documents and Setlings ooy Documents Wy Pictunes
Fis Bk Wew Tocks [némmet b

rorset A S e ey Do by D arecs U oren
111 r = Fn Ve T e
[ ) f G semew -
] i (o 0] Bwrnse [§) oot (G 3emon [ sere
m Acepins & Camets Setirgs Zoom Mede | Sercl Moda | Prenow Meode -
= Hodpae + - v (G- Gt —
=

w & a ToomMode | 5enol Mode | Pravise Mads
) view e cocaty i

[ frme— »

2 Click [1. Select Images] and select

. 7 ducalemeser X - 0:Mbueumests and SotliozalaHy Do vnswats by Piefurss\F ks LF004_09_0%
images.

| Bom e St ks | Priviem b
e =+t G- @

The background of the selected image(s) will
turn blue.
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3 Click [2. Select Captions for Printing]
and place a check mark beside the type
of information that will be printed with
the images.

#7 Zovmlteowser £ - D:\ocimens and Setlings ooy Decuments\y Pictins\F o\ 2004_09_09
Fle B vew Took bleet heb

“fou can chaosn o alach 10 aach image any or &l of the prop

If you select [Date and Time], for example,
you can print the images with their shooting
dates and times included.

Iﬁl You can add a comment to an image in the Properties Window (p. 31).

4 Click [3. Open Layout Print]. A R TR I

Edit View Tools Internet Help

1. SelectImages

“ou can choose to attach to ean

Select Captions for

[J Comment

[ File Name
Date and Time

PhotoRecord will start, displaying the
selected image and the information
selected in Step 3 in the Album window.
In addition, the steps that will take you
through the printing process will display on
the left side. Follow the steps in order to
proceed.

Album Window
The selected images display
here.

The printing procedures display here.

From this point onward, the procedures vary according to whether you select Full Page
Print (prints one image per page) or Layout and Print (prints an arrangement of images on
each page).



E

Full Page Print

This option prints one image per page.

1 dik [2 Select Printer & Album Type].
Once you have chosen a printer, select
[One Photo Per Page] or [One Photo Per
Sheet] in the Album Type category.

-
T2 Untitled - PhotwRecard

w
@
[
8
b
I @
1
3

Decorate
Amum

m auld Tiles

2 Click [3 Select Paper] and select the e
paper size and orientation. [ e £n view amum miames ol

Salect Printer
& Album [ype

WYIZZ'6L 6 +O0Z/B/E

M Decorate
i A

3 dlick [4 Print], confirm the number of
copies and other printing settings, and
click [Print].

Salect Papar

WWZZ5E

Dot
Albam @ a0

‘* T Pages

Auld litles
& Captions

XD a3

| Gk an drag photna of Figre.cle foe options

This will start printing.

To close PhotoRecord after printing is complete, click E Click [Yes] to save the album or [No]
to close it without saving. The ZoomBrowser EX window will reappear when the save
procedure is complete.
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Layout and Print

This option prints multiple images on a single page as in a photo album.

T Click [2 Select Printer & Album Typel. et e v
Once you have chosen a printer, select |1« wn ve s v e
[Free Form] in the Album type category. P

2 Salect Printer

& Abum Type

My Alum
2 ik [3 Select Paper] and select the e
paper size and orientation. (Fie con_veew_amum et iy
[ ackd Poge |
E Fetezh Photos I me MMM

Select Printer L
& Alum Tyme @ Medin Type

2[5

p ~ [?lm'\ Hn_ -
gl EI salect Paper Paper Sizr iy
[tener -
coraliz Fage Orieniy: o
‘| Al o
e Iim
3 Click [Decorate Album] and change the 5 S Sr—
design of the image background and S -ProtRecsrd G
border as desired. : -

W) Fetch Photes

Click the [Themes], [Backgrounds], [Photo =y (
Frames], [Text Frames] or [Clipart] button to Ef.':.m b
switch between selections.

Salect Papar

ﬁ Dot My Album
Albuam
Adld Titles
& Caplions
Perform the procedures according to the 2 e | ] = |7
instructions beside the [1] symbol. =Ll
2

Chck nnd drngy photna o right-chok foe options

*The [Themes] category provides consistent designs for use throughout
an entire album.

eYou can also click [Add Titles & Captions] to add text as a title or caption.
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4 cick [4 Print], confirm the number of W Saoctpapar || =
copies and other printing settings, and L8
click [Print]. E Dococste =l MyAlbum
O Poges T )
Aad Titles
& Caplions
- - | e
) Undo FJ n
(2 = ] T

18 Clhekt mnd deag photnas of right-chcll for options:
This will start printing.
To close PhotoRecord after printing is complete, click ﬂ Click [Yes] to save the album or [No]
to close it without saving. The ZoomBrowser EX window will reappear when the save
procedure is complete.

There are numerous varieties of albums. Select one to suit your purposes.
Please note that the available album types may vary slightly according to
the printer in use.

Album Type Dem

One Photo Per Page
One Photo Per Sheet

Prints one image on each sheet of paper.

Allows images to be freely positioned on the page

Free Form and printed.

Prints thumbnails of the images and their shooting
data (Exif data™*).

Allows image heights and widths to be specified and

Contact Sheet

Fixed Size Photo

prints.
Mosaic Lines up the specified number of images and prints.
Perforated Paper Prints on perforated paper.
8-Sticker Label Prints on 8-label sheets.

* The shooting information displayed in ZoomBrowser EX and the Exif data
that can be printed using PhotoRecord differ slightly.

This chapter explained the ZoomBrowser EX basics. Once you have mastered them, try the
advanced techniques.
Using the Software on the Windows Platform — Advanced Techniques (p. 26).

¢ A PDF-format manual for ZoomBrowser EX is also available. It provides
further information about the program's features and procedures. See Using
the PDF Manuals (p. 2).




This chapter explains various ZoomBrowser EX features.
Proceed to this chapter once you have mastered the basic ZoomBrowser EX procedures in the
Using the Software on the Windows Platform — The Basics chapter.

The ZoomBrowser EX Windows

This section describes the principal ZoomBrowser EX windows: the Main Window, Viewer
Window and Properties Window.

This window is for displaying and organizing images downloaded to the computer.

Task Area (p. 27) Function Buttons (p. 29)

— Display Mode
1(;)- 28)
Display Control

Panel (p. 29)

Browser Area (p. 27)

Folders Area (p. 27) Switches between showing and hiding
the Task Area and Folders Area.
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ooy Documents Wy PicturesiFlowe 2004,

Task Area

e ZoomBrowser EX's tasks are arranged here like
an index.

e Click a Task button to carry out the desired
task.
These features are described in ZoomBrowser
EX Features (p. 32)

FT Zoomirowser X - DiWDocuments and Seilings
YR v m (@) popmrns (S st st [T w1
oo Hisdt | Scro e | Prevess Moce,

2004_03.08 + [{-E-[r]A

& 1 e _01_30
13 2004 0

Folders Area

¢ Use this area to select folders. The images in the selected folder display in the Browser Area.
If you select a network drive in advance with Windows Explorer, you can display network
folders, but you cannot add, change or delete those folders in the Browser Area.

¢ |f you selected Favorite Folders, only the folders registered in advance as Favorite Folders will
display. You are recommended to register a folder that you use frequently as one of the
Favorite Folders. If you selected All Folders, all the folders will display.

Methods for Registering a Favorite Folder
o If "Favorite Folders" is displayed: click [Add] and select a folder.
o |f "All Folders" is displayed: select a folder and click [Add to Favorites].

Browser Area

¢ The images in the folder selected in the Folders Area will display here.
The display style will vary according to your Display Mode selection.

Methods for Selecting Images in the Browser Area

e Selecting a single image: click on an image.

o Selecting multiple images: click on the first image and then hold the [Ctrl] key down
while clicking on additional images.

e Selecting consecutive images: click on the first image and then hold the [Shift] key down
while clicking on the last image.

e You can sort the image order in the Browser Area by file name, shooting date or other
characteristics by clicking the [Tools] menu and selecting [View] and [Sort by].
¢ The following icons will display around images according to their attributes.

E Images shot with the camera's Stitch Assist mode
m RAW images
E Movies

Images with sound memo attachments
E Protected images
Images shot with the camera's AEB function
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Display Mode

e Selects the display style for the Browser Area.

Zoom Mode BT Fovmsltaierses B - D:Decuswnts and St ingsleodbly Documens Wy Pietur(F liwer\2004_09_00
Displays all the images in a folder as thumbnail |7 5/% & Saw gws o
images. This mode is convenient for searching
for images since many can be displayed at

once.

oo Mo | ool Mok | Pogvss Mok
Flomstt - = 4 -F- L& I

[l 4] =B
ume|

If additional folders are nested within a
folder, their images are displayed as
thumbnails as well.

RARIESES | PEES:

EilE wiya
R |

Scroll Mode ;
This mode is convenient for checking the — Sl B G G @
images in multiple folders at once. If the [ i

displayed folder is at the highest level, then all e :
thumbnails in the lower-level folders also
display. You can change the folder level (folder
depth) by clicking the [Tools] menu and
selecting [Preferences].

The images within nested folders also
display.

Preview Mode
This mode displays the image at a larger size as
well as the image information.

| -

Positioning the mouse pointer over a thumbnail causes the image to display
at a higher magnification. You can turn off this function by clicking the
[Tools] menu, selecting [Preferences] and removing the check mark from the
[Show mouse over windows] option.
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Display Control Panel

¢ This panel adjusts the display settings for the Browser Area.
Selection Menu Display Size

Use this to select or deselect all  Changes the size of the thumbnail in
the images in the Browser Area. the Browser Area.

- =+ 1 - - B |E O _J |:| Show | Al lmages v
Show/Hide Image Information Menu Filter Images

Use this to display or hide image This feature filters your images by
information beneath the thumbnails, such their Star Ratings, displaying only
as the file name, shooting date or Star those images in the Browser Area.
Rating. One of three Star Ratings can be

assigned to an image in the Viewer
Window, the Properties Window, or
in the information column in the
Preview Mode.

Function Buttons
¢ These buttons are available for executing various functions.

View Image Button Slide Show Button Rotate Button
Displays the selected image Starts a slide show of the Rotates the selected
in the Viewer Window. selected images. image.

Slide Show @ Search  |yjj| Delete g] Rotate -

[= 2

’5 Ly > .-J:
E Yiew Image Properties D??

Properties Button Search Button Delete Button
Displays information about Searches for images Deletes selected
the selected image in the using such criteriaasthe images or folders.
Properties Window. Star Rating,

modification date,
shooting date,
comments or keywords.
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Double-click an image in the Browser Area to display it in the Viewer Window.

Edit Menu ) Split Screen Button Synchronize Button
You can use this Displays multiple images at once. Synchronizes the
menu for red-eye This is handy for comparing images. display settings when

multiple images are
displayed.

reduction, color
correction and
cropping. You can
also use it to start up
other programs for
editing.

Star Rating
Sets the Star Rating
for an image.

Image Selector Button
Switches between
images.

Sets theimage display
size to the size in the

VR VRV Full Screen Button
Displays the image in the full screen mode. Click the
Zoom image or press any key on the keyboard to restore the

Changes the image normal display mode.
zoom setting.
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Properties Window

The Properties Window displays when you select an image in the Browser Area and click the
Properties button. The Properties Window does not display in the Preview Mode.

Shows or hides

categories. EE Properties &3
. _ Modiied 5/2/2004
Star Rating A FieSie 06 KE
Sets the Star Rating y Image Size: 1600 % 1200
for an image. Y FieType PG
Sound
——* Plays a sound memo attached
Path: [:4Diocuments and Settingshssxiidy Docu to on image.
{2 File Name:
M _0001

p— Protect
“;%3%‘* : & Prevents an image from being
Protect overwritten or deleted.

Commet: —|_
—Comment

You can type a comment here.

i

—
Kepwards: Keywords
Sets the keywords used in

e searches.

|-—Histogram
A graph of the highlights and
shadows distribution in an
. . | image.
ghsoolglr;gdler?tgolren(;atlon Shooting [nformation: g
i i : )
infgrrrilation about the F”T»Tt?i"ueum.wa 2
shooting settings when the —J Fare/2 Mol ame
image was captured, such Shosting D ate/Time 2
as the shutter speed or = T N
exposure setting. The ( sious S —Image Selector Buttons
camera model will Switches between images.

determine what
information is displayed.
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ZoomBrowser EX Features

This section briefly introduces the Task Area functions.

Acquire & Camera Settings

Opens the Camera Control Window, which lets ‘i:_@ acquire & Camera Settings
you perform the following operations.

Acquire Images
Downloads images from the camera/memory card (p. 15, 19).

Set to Camera
Sets camera settings, such as the My Camera settings (p. 45), or Slide Show/DPOF settings. It
also uploads images from the computer to the camera/memory card.

Remote Shooting
Allows you to operate the camera shutter from the computer (p. 41).

View & Classify —

=L .
View as a Slide Show 7 Wiew & Classify
Starts a slide show of the images selected in the ==

Browser Area.

Rename Multiple Files
Changes the file names of the selected images in a single pass.

Classify into Folder
Classifies images and saves them into a specified folder.

Search

Performs image searches using criteria such as the Star Rating, modification date, shooting
date, comments or keywords. Star Ratings, comments and keywords can be set in the image
information column in the Preview Mode or in the Properties Window.

Edit —
Edit Image '@ E dit
Allows you to perform image editing, such as

cropping, color correction and red-eye
reduction. You can also use it to start other image editing programs.

Stitch Photos
Merges multiple images and creates a single large panoramic image (p. 44).

Edit Movie
Edits movies or still images strung together. You can add text as titles, or background music,
and apply various effects (p. 37).



Process RAW Images

Converts RAW images into standard images. You can adjust the image brightness, contrast

and color balance among other attributes during conversion (p. 38).

Export
Export Still Images |@ Expart

Allows you to change the image size or type,

and export it as a new image.

Export Movies
Allows you to change the movie size or type, and export it as a new movie.

Export Shooting Properties

Allows you to select the necessary data from the shooting information and export it as a text

file.

Export as a Screen Saver
Exports the image as a screen saver file.

Export as a Wallpaper
Exports the image as a wallpaper file.

Backup to CD
Copies images to a CD-R/RW disk for backup.

The Backup to CD function can only be used on computers satisfying the
following requirements.

e \Windows XP is preinstalled

e A CD-R/RW drive is included as standard equipment

Print

Layout Print
Allows you to arrange the selected images in an

Fririk

attractive layout and print them (p. 21).

Contact Sheet Print
Prints the selected images as a contact sheet (index).

Internet i
Email Images ‘ Intermet

Converts the selected images to the

appropriate size for transmission by e-mail. You
can also use it to automatically start an e-mail program after conversion.

Menu] at the bottom of the task screen.

menu, [?] button or [Help] button to display topics about operational
procedures or the functions available.

Iﬁl e To return to the previous screen after selecting a task, click [Return to Main

e Various Help functions are available in ZoomBrowser EX. Click the [Help]

|33
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Checking Images before Downloading

Checking Images before Downloading

You can display camera or memory card images in the Camera Browser Window to view them

before downloading.

T rerform Step 1 in the Camera to Computer Connection section (p. 15) or steps 1-2

in the Memory Card Connection section (p. 19).
The Camera Control Window will display.

2 Click [Lets you select and download 3
images]. ;

Downloads using computer

| 3‘5’@[ Starts to download images
M=
i [ﬁ@ Lets you select and download images

Preferences...

Displays this screen when the camera is connected

The images in the camera or memory card will display in the Camera Browser Window as

thumbnails (tiny images).

& CameraWindow - Canon JO0G0BM00
File(F) Edb(E) View(¥) Help(

——Camera Browser

STA_D00AJPG STE_0010.JPG STC_0011.JPG STD_00M2JPG

STA_0008.JPG —l
Canon RRXHERERR
5/13/2004
3:08:33 PM

Detailed Image Infarmation

[File Marne

3 Sselect images to download.

S5TA_0003.JPG
[Camera Model Name
Foanan 3¢ DIGITAL |

~

Window

L Thumbnail

To select multiple images, click on the first image and then hold the [Ctrl] key down while

clicking on successive images.

4 ik [Download pictures].

a do ano
Fie{F) EditE} Wiew() HelptH)

7% Download pictures E& h E’M?ediu;”

M@ & @

STA_0009.PG

STB_00M0.UPG

STC_O0011.JPG




5 Confirm the destination folder and click .
CameraWindow - Download Images [E3]
[Starts Download]. I
| Do nat modify ~|
Specify the file name for saved images. _| e
Assign Sequence Mo,
. . . Murmber of
Specify the destination folder for the ctan
images.

You can change the destination folder by
clicking [Browse] and selecting a new

SpegEoda

destination. Save to [Folder Name)
D:\Documents and S ettingshas\My Docu ]
Select [Create subfolder] to create a new B A b s s o)
folder within the one specified above, and — . ... .ooom
select a naming option. Shosting FeartoninDate 5
Hew Name

Example [ ] D:\Documents and S ettingsbambiph... by Pictun
Z1 2003_12_31

‘ Starts Dovwnlaad ’ Cancel

The thumbnails of the downloaded images will display in the Main Window of
ZoomBrowser EX when downloading is complete.

displayed in the Camera Browser Window and dropping them onto the

Iﬁl You can also download images to the computer by dragging images
Browser Area or Folders Area in ZoomBrowser EX.

Other Methods of Downloading Images to the Computer
There is no need to install ZoomBrowser EX with either method.

* Windows XP (Installation of USB Driver Not Required)

Your camera uses a standard image transfer protocol called Picture Transfer Protocol (PTP).
With PTP and Windows XP, all you need do is connect the camera to the computer with an
interface cable to easily download images using the Scanners and Cameras Wizard or other
procedures. However, there are some inconveniences and limitations to this downloading
method. See the For Windows® XP and Mac OS X Users leaflet for details.

* Windows Me (with the USB driver installed)
Easily download images using the Scanners and Cameras Wizard or Windows Explorer. All
you need do is connect the camera to the computer with an interface cable.

See the Windows Help system for information about the Scanners and Cameras Wizard and
Windows Explorer.

35
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Replaying Movies

Installation Procedures for QuickTime
QuickTime is required to play and edit movies. To install QuickTime, please follow these
procedures.

1. Place the Canon Digital Camera Solution Disk in the CD-ROM drive.
If the installer panel fails to appear automatically, display it using the procedures in the
How to Display the Installer Panel section (p. 11).

2 Click the QuickTime [Install] button.
Canon DIGITAL CAMERA

Solution Disk

Digital Camora Softwars

Install

Exit

Follow the onscreen instructions to proceed with the installation.

1 Double-click an image with a movie
icon in ZoomBrowser EX's Browser
Area.

2 Click the |I| (Play) button in the
Viewer Window.

Windows Media Player or QuickTime Player
will start.

3 Cclickthe &’ (Play) button in Windows
Media Player or QuickTime Player.

2o at: e,

0 Do not Wick a movie file in the Windows Explorer to play it. That will

start Windows Media Player, which may not support this file type. To replay
movies, start QuickTime Player through the [Start] menu and open the file
using the QuickTime Player [File] menu.
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Editing Movies

You can create and edit movies: link movies and stills that have been downloaded to your
computer, add background music, superimpose titles and other text, and apply various effects
to the movies.

¢ QuickTime is required to play and edit movies. Use the Installation
Procedures for QuickTime section (p. 36) to install it.
e Movies are saved as Motion JPEG AVI movies.

Click [Edit] in ZoomBrowser EX’'s Main Window, followed by [Edit Movie].

2 Click [1. Add Images] and select the image (movie or still) you wish to edit.
You can select multiple movies or stills.
3 Follow the steps at the left of the window to edit the movie and save it.

Follow these steps Click this button for detailed
to proceed. operational instructions.

—— Instructions

Click this button to
play the movie

being edited.
St.oryboard Area_— Transition Effects Box
!Dlsplays thumbnails of the selected Appears between adjacent images
images. and displays the symbols of the

Links images in order from left to right. transition effects linking images.
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Converting RAW Images

RAW images are extremely high-quality images that are not subject to any deterioration due to
compression processing. Since they are a special type of image, they cannot be opened by
many image editing programs. It is first necessary to convert them into standard image files.

¢ See Information about Your Camera (p. 94) to determine whether your
camera model supports this function.

*See the Camera User Guide for information about the camera settings for
shooting RAW images.

Procedures for Converting RAW Images

1
2

3

Select a RAW image in ZoomBrowser EX's Browser Area.

Click [Edit], followed by [Process RAW Images].

The Main Window, the Navigator window Main Window
and the Image Quality Adjustment Window
will display.

Use the buttons here to switch between
images and display modes, rotate images,
and set the conversion parameters.

Thumbnail
Check Mark

If the navigator window does not display, click the [View] menu and
select [Show Navigator].

Adjust the image quality as required in the Image Quality Adjustment Window.

This window is explained in the Functions of the Image Quality Adjustment Window
section (p. 39).
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4 Click the [2. Save] tab, set the file type
and destination, and then click [Save].

Select [All Images] or [Checked Images] |

(images checked in the main window) to .
apply the common conversion settings. o T e 6200

Select a file type

Set the file destination

Rt Bocpaarce ™

You can also change the file name —J - e o

This will convert the image.

5 Click the [3. Exit] tab and click [OK].

Functions of the Image Quality Adjustment Window

The following adjustments can be made in the Image Quality Adjustment Window. The
available settings may vary depending on the camera used.

Image Quality Adjust... E|§|@
Camera type: XXOOOOOOX Tone Curve Tab

General Adjustments (Tone ¢ ‘tYhoeuRcéE i?]tatlh:ellivels for
(“\wihite Balance

. . . W separately or together.
This section adjusts the |Aum - zl

white balance according
to the light source and

L Advanced Adjustments

-|5 1 Tab

Colortemperature

color temperature. {2000-10000) You can set the settings
Magenta Green l—— for adaptive noise
L . control and the color
FIU2 ot ) space for the output.
(Digital Exposure Compensation )
Thi§ section adjusts the ——— 4 00 If you cannot set the
digital exposure -2.0-+2.0) L—desired setting with the
compensation, photo Phato Efect slider on the left, directly
effect, contrast, ) ot = enter the setting here.
sharpness, and saturation.
Contrast
[ o
Sharpness £5-45)
- T
Saturation -1
The effect of the settings v
above can be viewed \ ) B
immediately if you place a—iv Preview ) .
check mark here. Reset | +—1 Applies the settings to

the displayed image

Restores all settings to the settings stored
in the camera at the time of shooting.
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Converting RAW Images

Gl

You can change the coloration of the image to your preferred settings when
you convert a RAW image. You can also select preset color schemes, such as
Positive Film. Furthermore, you can add your own color schemes (My Color) to
apply to other RAW images when they are being converted. See the PDF
manual for ZoomBrowser EX for more information (p. 2).




Operating the Shutter Remotely

You can record still images by using a computer to control the shutter of a connected camera.
This is particularly useful for checking images on the larger display of the computer as you
record them and for high volume photography without worrying about filling the camera’s
memory card.

Preparing for Remote Shooting

1 Attach the supplied interface cable to the computer's USB port and the camera's
DIGITAL terminal and place the camera in the correct mode for connecting.

e Methods for connecting the camera to the computer and placing it in
the correct mode for connecting vary between models. Some cameras
need to be in Playback mode when connected to the computer, please
refer to the Information about Your Camera section (p. 94).

e Perform the settings described in First Time Camera is Connected to a
Computer (p. 16) the first time you connect the camera to the

computer.

The Camera Control Window will display.

2 Open the lens cover or remove the lens cap on models equipped with them.
Proceed to the next step if your model does not have one.

3 CIICk the [RemOte ShOOtlng.] tab CameraWindow - Canon XXXXXXXXXXT
Click [Starts Remote Shooting]. T T

| Starts Remote Shooting

Displays this screen when the camera is connected

5 sclect a destination for the captured images and click [OK].

41
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Operating the Shutter Remotely

RemoteCapture Task Window

The RemoteCapture Task window has the following features.

Shows/Hides the Size and Resolution Selector
viewfinder or detailed Selects the size and resolution at which images are captured.
settings area.

Rotation Settings

RemoteCaptureTask aE Sets the rotation
Fis(E) CameralS) Shooting(3) Helpid) _parameters for
@ Hidke *iewFincler @_ 4L H T ::r;]atguerse?jfter thEy are
() Hide shooting detaits % . P
You can add =] Addcammerts shown belaw :
I Release Button

comments to images
by placing a check
mark here and
typing text in the
boxes below.

Releases the
shutter.

Slide this to zoom
the camera in or out.

Start/Stop Viewfinder
Button

Starts or stops the
viewfinder display.

Viewfinder Display
Click the [Start/Stop
Viewfinder] button
while a connection to
the camera is open to
display the image
appearing in the
camera'’s viewfinder.

Refresh Button
Resets the exposure,
focus and white

| balance.

Set the basic camera settings here.

camera models.

e RemoteCapture Task locks the exposure and focus settings for the subject
matter in the Viewfinder section. If the lighting or distance to the subject
changes, click J&% to reset these settings.

Iﬁl e The settings available in the RemoteCapture Task window vary between
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Remote Shooting

Ensure that you turn off your computer’s standby mode before you begin
remote shooting. The device performance cannot be guaranteed if the
computer enters the standby mode.

Click and check the subject in the viewfinder.

Change the image size or resolution, the rotation settings and the settings at the
bottom of the window as required.

If you intend to hold the camera vertically to photograph a subject, you can save the
image to the computer with the correct orientation if you set the rotation settings in
advance.

N =i

If your camera is equipped with the Auto Rotate function and you set it
to On, the image will automatically be rotated and appear in the correct
viewing orientation in the RemoteCapture Task window.

3 Click the [Release] button.

*You can release the shutter by pressing the camera’s shutter button or
the keyboard’s space key.

e Other than the shutter button, the camera's buttons and switches,
including the zoom, cannot be operated while the camera is being
controlled with the Remote Shooting function.

*You may notice that the interval between the shutter release and
activation is slightly longer for remote shooting than when the camera
is used independently.
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Merging Panoramic Images - PhotoStitch

Merging Panoramic Images - PhotoStitch

You can create a wide panoramic image by merging several images. It is easier to merge
images if they are shot with the camera's Stitch Assist mode because PhotoStitch can
automatically detect the image order and orientation.

Images Shot in Stitch Assist Mode

A sequence of images shot in Stitch Assist mode is saved into a single folder when it is
downloaded from the camera. In addition, the symbol below displays by the image in the
Browser Area.

Symbol displayed by images shot in Stitch Assist
mode.

Assist mode.
eImages shot in Stitch Assist mode with a wide converter, teleconverter
or close-up lens cannot be merged accurately.

Iﬁl e See the Camera User Guide for information about shooting in Stitch

Starting PhotoStitch

1 cik [Edit] in the ZoomBrowser EX's Main Window and click [Stitch Photos].

2 Click [1. Select Images] and select several images in the Browser Area.

3 Click [2. Open Photostitchl. )
B [Mersimiee =

Stitch Assist Mode

Instructions

sTagon #

s | swomes

o e §

4 Merge the images following the instructions in the guidance panel at the top of
the PhotoStitch window.
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Enjoy Customizing Your Camera with the My
Camera Settings

The start-up image, start-up sound, shutter sound, operation sound, and self-timer sound are
called the My Camera settings. You can add your favorite images and sounds from your
computer to the My Camera settings. This topic explains how to upload the My Camera
settings saved onto your computer to the camera and vice versa.

Displaying the My Camera Window

1 Attach the supplied interface cable to the computer's USB port and the camera's
DIGITAL terminal and place the camera in the correct mode for connecting.

e Procedures for attaching the camera to the computer and placing it in
the correct mode for connecting vary between camera models. See
Information about Your Camera section (p. 94).

e Perform the settings described in First Time Camera is Connected to a
Computer (p. 16) the first time you connect the camera to the
computer.

The Camera Control Window will display.

2 Click the [Set to Camera] tab.
3 Click [Set My Cameral.

=]
&—-‘i Set Slide Show/DPOF

‘ :!—%F Confirms/changes camera settings

&=

&)

Uploads images to the camera

Displays this screen when the camera is connected
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The My Camera Window Features

ZoomBrowser EX already contains several pre-recorded My Camera settings. You can check

these items with the My Camera window.

Tabs

Click here to switch between adjusting the settings individually or in themed sets.

| T e—— ] P12y Button

et at B S0 vl |

Sabsct My Camarn [ath o and 8t individuslly

Displays the list of — o e
settings files saved P o
onto the computer. || & : .

Add File Button
Adds the settings file
to the list.

£z

&

ToZZanLerEE
EL

cooo

Sooo

Play Button

Plays the audio from
the selected settings —— ..
file.

L Plays the audio from the
settings file in the
camera.

Displays the settings in

—— the camera.

Duite

+

L Delete Button
Deletes a settings file
from the camera.

Save to Camera Button

Saves a computer
settings file onto the
camera.

I
_ail
Clan |

Delete Button
Deletes a settings file from
the computer.

Create a My Camera Sound Button
Starts My Camera Sound Maker (p. 48).

Save to PC Button
Saves a camera settings
file onto the computer.

Not available when My Camera Window is opened from the Camera Control Window.

Iﬁl the My Camera Window (p. 47).

You can add new data to the My Camera window. See Adding New Data to

Saving the My Camera Settings to the Camera

My Camera settings can be selected and saved in either of two ways to the
camera: individually or in theme sets.

*The “Animal” theme, for example, features an animal in the start-up image
and animal calls in each of the sound files. The names of the prepared files
for the various My Camera settings themes all begin with the same root
name. The start-up image and sound files in the "Animal" theme, for
example, all begin with "Animal~".

0 Do not detach the interface cable, turn the camera power off or disconnect
the camera from the computer while the My Camera settings are being saved
to the camera or the settings from the camera are being saved to the

computer.



1 selectthe [Setup as a theme] tab in the My Camera window.
To set the start-up image or sound individually, click the [Set individually] tab and select it.

Select the settings file you wish to save to the camera from the My Computer list.
Select the setting from the Camera list that you would like to change and click
[Save to Cameral.

This concludes the process of saving the My Camera settings to the camera.

The Camera list setting will change to the selected file. If a setting for this category has
previously been saved to the camera, it will be overwritten.

WN

Repeat steps 1-3 as required.
To use this data on the camera, change the start-up image and sound settings on the
camera itself. Please see the Camera User Guide for these instructions.

Saving the Camera’s My Camera Settings to the Computer

1 selectthe [Setup as a theme] tab in the My Camera window.
To set the start-up image or sound individually, click the [Set individually] tab and select it.

Select the settings files from the Camera list that you wish to save to the
computer.

Click [Save to PC].

Add a name to the settings file you are saving and click [OK].

This concludes the process of saving the My Camera settings to the computer.
Repeat steps 1-4 as required.

Adding New Data to the My Camera Window

Create a new image or sound file and add it to the My Camera window.

R N

Create an Original Start-up Image File and then Add It

Start by using an image editing program to create the image file that will become the start-up
image and save it to the computer. Create a JPEG image at a size of (w) 320 x (h) 240 pixels.

1 Open the My Camera window, click the
[Set individually] tab, select [Start-up
Image] from the "Data Type" category S s R B
and click the [Add File] button.

e a1 2 e

Camer

3 GOLFN S0

> (B

S
Sipen 42 Camara |
S l -
|

47
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2

Select the file you created and click [Open].

This concludes the process for adding new data.

You can save the newly created data to the camera using the procedures described in the
Saving the My Camera Settings to the Camera section (p. 46).

Create an Original Sound File and then Add It

It is easy to create a sound file using My Camera Sound Maker.
QuickTime is required to play the recorded sound.

2

Click the [Edit] menu in the ZoomBrowser EX Main Window and select [Manage
My Cameral.
The My Camera window will display.

Select the [Set individually] tab in the My Camera window and click the [Create a
My Camera Sound] button.

The My Camera Sound Maker program will
start.

=5 My Camera Sound Maker

Start_up Sound Creating

Click [Fresord] ta record sourd or dlick [Open] to open s

Create a file following the instructions
in the guidance panel.

Instructions

Click ©) once you have saved the sound file to close My Camera Sound Maker.

This concludes the process of adding a sound file as a My Camera settings file to the
computer.

You can add the file to the camera with the procedures described in the Saving the My
Camera Settings to the Camera section (p. 46).

e Record the sound as an 11.025 kHz or 8.000 kHz, 8 bit, mono WAV
sound file.
*The following chart shows standard time lengths for My Camera
Sounds.
Duration in Seconds
Type
11.025 kHz 8.000 kHz
Start-Up Sound 1.0 sec. or less 1.3 sec. or less
Shutter Sound 0.3 sec. or less 0.4 sec. or less
Operation Sound 0.3 sec. or less 0.4 sec. or less
Self-Timer Sound 2.0 sec. or less 2.0 sec. or less




This chapter explains the basic procedures for installing the software. Read this material before
you connect the camera to the computer for the first time.

Installing the Software

Start by installing the software from the Canon Digital Camera Solution Disk.

See ArcSoft PhotoStudio (p. 80) for details on how to install ArcSoft
PhotoStudio.

ltems to Prepare

e Your camera and computer
¢ Canon Digital Camera Solution Disk
e Interface cable supplied with the camera

Installation Procedures

Close any programs that are running.

Place the Canon Digital Camera Solution Disk in the
computer’s CD-ROM drive.

3 Double-click the [Canon Digital Camera Installer] icon

@ in the CD-ROM window.

4 cick the Digital Camera Software
[Install] button. canon

Installer Panel
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Select [Easy Installation] and click
[Next].

Select [Custom Installation] to select
programs individually for installation.

Click [Agree] if you agree to all of the
terms of the software license
agreement.

Review the installation settings and
click [Next].

Follow the onscreen instructions to
proceed.

When the installation is over, click [OK].

Click [Exit] in the installer panel and

remove the disk from the CD-ROM drive.

This concludes the software installation.

Sebecting an Installasion Type

Salwct an installation fype and chick [Mext).

Cuvtom Installat

5. W recommend this aption for users unfumiliar with the

Lets you sebect the rograms you want b install. We recommend this option for users
famikar with the installaton.

Starting Inszallation

Instaliation will begin using the sentings isted below. Click [Next] to start copying files.

dy,

Installation has finished.

with these procedures.

See Uninstalling the Software (p. 82) to delete the software installed

Continue by downloading images to the computer (p. 51).




This chapter explains the procedures for using ImageBrowser to download the camera's images
to the computer and print them.

Read this chapter after completing the preparations in the Using the Software on the
Macintosh Platform — Preparations section.

Downloading Images to the Computer

Begin by downloading the images to your computer. The downloading procedure is slightly
different according to whether you are using a camera to computer connection (see below) or
a memory card reader (p. 53).

th are more than
card reader to

You may not be able to download the ca
approximately 1000 images in the ca
download in that case.

You can also display an index of the camera or memory card images to check
them before downloading or download them selectively. For instructions, see
Checking Images before Downloading (p. 66).

Camera to Computer Connection

Set the ImageBrowser auto start settings before you connect the camera to the computer for
the first time. This step is not required from the second connection onward.

ImageBrowser Auto Start Settings — OS X (v10.2/v10.3)

1. Start Image Capture, click the [Image Capture] menu and select [Preferences].

2. In the next menu, click the [When a camera is connected, open:] list box and select
[Other].

0

% iPhoto

-__—— v B Image Capture

No application

When a camera is connected, ,6 Other..

The window will appear
slightly different in v10.2.

3. Select [CameraWindow] in the program selection window.
CameraWindow is generally installed into the folder opened by selecting the
[Applications], [Canon Utilities] and [CameraWindow] folders.

4. Click [OK] and then close Image Capture.
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Downloading Images to the Computer

ImageBrowser Auto Start Settings — OS X (v10.1)
1. Start Image Capture and select [Other] from the Hot Plug Action list box.

z 88o Image Capture

@ Download To: = Pictures, Movies, and Music folders "?1

Automatic Task: | None 3

Oceurs after downloading

Hot Plug Actior « Image Capture Application '
None

= @

2. Select [CameraWindow] in the program selection window.
CameraWindow is generally installed into the folder opened by selecting the
[Applications], [Canon Utilities] and [CameraWindow] folders.

3. Close Image Capture.

1 Attach the supplied interface cable to the computer’s USB port and the camera’s

DIGITAL Terminal. Prepare the camera for communication with the computer.

Procedures for attaching the camera to the computer and placing it in
the correct mode for connecting vary between camera models. See
Information about Your Camera (p. 94).

The Camera Control Window will appear.
Double-click the [Canon CameraWindow] icon on the desktop if it does not appear.

2 Click [Starts to download images]. 0.00 Canon XXXXXXXXXX

.,—chuire Images | Set to Camera | Remote shooting }

@l Starts to download images
\_,'

s,

Camera Control Window

Lets you select and download images

You can set the type of image to download
and the destination folder by clicking
[Preferences].

' Preferences... ) ( Quit ]

The downloaded images will be saved into folders according to their shooting date.

¢ By default, all the images that have yet to be downloaded will
download to the [Pictures] folder.

¢ To download images that have had their transfer settings set with the
camera, click [Preferences] and select [Images whose transfer settings
were specified with the camera] as the image type to be downloaded.
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By default, when the download is complete, the thumbnails (tiny versions) of the
downloaded images display in ImageBrowser’s Browser Window.

ann e Wk
Tk —

Continue by printing out an image (p. 55).

Memory Card Connection

Set the ImageBrowser auto start settings before you connect a memory card to a computer for
the first time (p. 51).
This step is not required from the second connection onward.

T insertthe memory card into the reader.

Use a separately sold card adapter (PCMCIA adapter) if required.
See the manual for the memory card reader for details on how to connect and use the
reader.

(2) Insert the loaded adapter into the slot.

(1) Place the memory card in an adapter if required.

The card adapter and memory card shape may vary
acclording to the type of memory card your camera
utilizes.

The Camera Control Window will appear.
Double-click the [Canon CameraWindow] icon on the desktop if it does not appear.
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2 Click [Starts to download images].

000 XXXXX

—[ Acquire Images | Set to Memory Card )

|| starts to download images

You can set the type of image to download ——
and the destination folder by clicking ‘ﬂﬁl | ets you select and download images
[Preferences].

Preferences...

1 [4 Quit )
~ e J

.

The downloaded images will be saved into folders according to their shooting date.

¢ By default, all the images that have yet to be downloaded will
download to the [Pictures] folder.

*To download images that have had their transfer settings set with the
camera, click [Preferences] and select [Images whose transfer settings
were specified with the camera] as the type of image for downloading.

e See Memory Card Folder Structure (p. 85) for information about
memory card folder structures and file names.

By default, when the download is complete, the thumbnails (tiny versions) of the
downloaded images will display in ImageBrowser's Browser Window when downloading
is complete.

Continue by printing out an image (p. 55).
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Printing Images

T select the images to print.
Clicking on an image selects it and displays a blue frame around it. To select multiple
images, hold down the [shift] or [ 8] (command) key while clicking on images.

Bt Woniirn

[Powiem Lnt  TimaTunnat

@ A blue frame
3 = 2 @ = =» displays around
''''' e selected images.

=

Iﬁl Movie images cannot be printed.

2 Click the [Print] button and select

[Layout printing] from the displayed :
menu. % ‘ @

This displays the Layout Options dialog and Internet
the Print window. <

ans Print

Layout Options dialog :

Layout Opticn:

Prevew
Heres would you ke 1o print your photas?

& Custom layout printing

Print window

J index printing

) Fixed photo size printing

() Titedt phate prirting

Prints each image at the indnddually
specified size and position.

From this point onward, the procedures vary according to whether you select Full Page
Print (prints one image per page) or Layout and Print (prints an arrangement of images on
each page).
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| Printing Images

Full Page Print

This option prints one image per page.

h W Na

Select [Tiled photo printing] in the Layout Options dialog and click [Next].

Once you have set the paper size and other settings, select [1 (1 x 1)] in the No. of
images category and click [OK].

Click the [Print] button in the Print window.
This will display the Print dialog.

Click [Print] to start printing.

Layout and Print

This option prints multiple images on a single page as in a photo album.

1
2
3

]

Select [Custom layout printing] in the Layout Options dialog and click [Next].
Select settings, such as the paper size, and click [OK].

As required, change the layout and add text in the Print window.

See Print Window Features (p. 57) for the procedures for changing layouts and adding
text.

Click the [Print] button in the Print window.
This will display the Print dialog.

Click [Print] to start printing.

*You can print image thumbnails by selecting [Index printing] in the

Layout Options dialog.
eImages shot with Exif 2.2-compliant cameras (Exif Print) incorporate

information about the shooting settings, such as the camera modes and
settings. Better prints can be made by using this information to correct
the image. To set this function, click the [ImageBrowser] menu and
select [Preferences]. Select [Print] from the list box at the upper left of
the Preferences window and select the desired settings in the "Image
Correction Settings" category.
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Print Window Features

When the [Custom layout printing] option is selected in the Layout Options window, you can
freely change the size and position of the images for printing.

‘@O 06 Print

Fiowers Edit the Page'TitIe
Open the [Edit] menu
and select [Edit
Header].

Change the Image Size
Drag the border to
resize the image.

Change the Layout
Drag the images to
change the layout.

Add Captions to Images
Click the image and
then the [Edit] menu
and select [Edit
Caption].

Add Text
Open the [Edit] menu
) and select [Add Text].

Change the default

number of images |
printed per page. Flopers L

[ — Displays the Layout
Vertically and = g 0 E = Options window.
horizontally lines up a1
images in the RE-LAYOUT ROT| TE‘U FER P AGE OPTIONS FRINT
window. ezl il fag: 173 7

Displays the Print dialog.

Rotate the selected
image.

the [ImageBrowser] menu and select [Preferences]. Select [Print] from the list box
at the upper left of the Preferences window and place check marks besides the
desired items in the "Items to Print in Caption" category.

Iﬁl To print the shooting date, shooting time or the file name as the caption, click

This chapter explained the ImageBrowser basics.

Once you have mastered them, try the advanced techniques.
Using the Software on the Macintosh Platform — Advanced Techniques (p. 58).

A PDF-format manual for ImageBrowser is also available. It provides
further information about the program's features and procedures. See
Using the PDF Manuals (p. 2).




This chapter explains various ImageBrowser features.
Proceed to this chapter once you have mastered the basic ImageBrowser procedures in the
Using the Software on the Macintosh Platform — The Basics chapter.

The ImageBrowser Windows

This section describes the principal ImageBrowser windows: the Browser Window, Viewer
Window and File Information Window.

This window is for displaying and organizing images downloaded to the computer.

Browser Area (p. 59)  Display Mode (p. 60)

Fily M L
Basficution Dt Wied Jun B, 204 LI P
ez

vmage s

e Formas

o

(s

| o baing

s

N_OO03 NG _G004
G

| Selectng mages || 1 0 @

Explorer Panel (p. 59) Display Control Panel (p. 61)

Control Panel (p. 61)
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Explorer Panel

e Use this area to select folders. The images in the selected folder display in the Browser Area.

¢ If you selected Favorite Folders, only the folders registered in advance as Favorite Folders will
display. You are recommended to register a folder that you use frequently as one of the
Favorite Folders. If you selected All Folders, all the folders will display.

Methods for Registering a Favorite Folder
o If "Favorite Folders" is displayed: click [Add] and select a folder.
o |f "All Folders" is displayed: select a folder and click [Add to Favorites].

Browser Area

¢ The images in the folder selected in the Explorer Panel will display here.
The display style will vary according to your Display Mode selection.

Methods for Selecting Images in the Browser Area

e Selecting a single image: click on an image.

e Selecting multiple images: click on the first image and then hold the [shift] or [§§ ]
(command) key down while clicking on additional images.

e Selecting consecutive images: click on the first image and then hold the [shift] and
[option] keys down while clicking on the last image.

e The following types of icon will display around images according to their attributes.
Cha Images shot with the camera's Stitch Assist mode
RAW images
- Movies
F.Iﬂ Images with sound memo attachments

[ Protected images
2y Images shot with the camera's AEB function
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Display Mode

e Selects the display style for the Browser Area.

Preview Browser Window
This mode displays the image at a larger size as SR L
well as the image information.

M"ﬂﬂ&

MG_D001 PG MG_DO02_BG HO0S PG G_DOG, I IMG_000%_ PG MG._D006. G MG_D007, 3%

List Mowsar window
Displays the images in the folder selected in the Lot S
Explorer Panel section in rows and columns. > -

TimeTunnel

Displays images in chronological order in a
simulated time tunnel. You can move along a
timeline from the past to the present using the
slider that appears at the window's right.
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Display Control Panel

¢ This panel adjusts the display settings for the Browser Area.

Display Size Selection Menu

Changes the size of the thumbnail in Use this to select or deselect all

the Browser Area. the images in the Browser Area.
View | Show All [ Q @ “ Selecting Images v| l )

1 1 1 1 1 1

Filter Images Hide Buttons
This feature filters your images by their Star Left:  Hides the Explorer Panel.
Ratings, displaying only those images in the Middle: Hides the control panel.
Browser Area. Right: Hides the image
One of three Star Ratings can be assigned to information in the Preview
an image in the Viewer Window, the File display mode.

Information Window, or in the information
column in the Preview display mode.

Control Panel
¢ The control panel contains buttons for executing various functions.

§ 83 o0 WA \8

Canon Camera Wiew Image SlideShow Internet - Frint - Send to Trash

The functions displayed here are explained in the Control Panel Features section (p. 64).
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Double-click an image in the Browser Area to display it in the Viewer Window.

-T-1:] A IMC_0001 JPC

Zoom
Changes the image
zoom setting.

‘it f#—— Star Ratings Menu

Fit 10 window =] (
Image Selector 2T ¢ 5 = = = Sets the Star Rating for
Button s e | v T v e Rt an image.
Switches between - IR
Images. Full Screen Button
Save Button Displays the image in the full
Saves the edited screen mode. Click the image or
image. press any key on the keyboard to
restore the normal display mode.
Edit Menu .
Allows cropping and color Synchronize Button
correction. Synchronizes the display
You can also use it to start up settings when multiple
other programs for editing. images are displayed.

Number of Displays Menu
Displays multiple images at
once. This is handy for
comparing images.
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File Information Window

The File Information Window displays when you select an image in the Browser Area, click the
[File] menu and select [Get Info]. The File Information Window does not display in the Preview

display mode.
Star Rating Menu
Sets the Star Rating for an image.
. (afalal File Information
Shows or hides "-‘”‘"L =
categories. Bl |
| ~Comment
_J_You can type a comment
. here.
Plays a sound memo T ' Keyword
attached to an image. D S Sets the keywords used in
we searches.
L Histogram
Lock ; A graph of the highlights
Prevents an image L e and shadows distribution
from being in an image.
overwritten or
deleted.

Image Selector Buttons
Switches between images.

Shooting Information

Displays detailed information
about the shooting settings when
the image was captured, such as
the shutter speed or exposure
setting. The camera model will
determine what information is
displayed.
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| ImageBrowser Features

ImageBrowser Features

This section provides a brief introduction to ImageBrowser features.

Control Panel Features
3 7 @ & 8

Canon Carnera Wiew Image SlideShow Intetnet - Print - Send to Trazh

Canon Camera
Opens the Camera Control Window, which lets you perform the following operations.

Acquire Images
Downloads images from the camera/memory card (p. 51, 53).

Set to Camera

Sets camera settings, such as the My Camera settings (p. 76), or Slide Show/DPOF settings. It
also uploads images from the computer to the camera/memory card.

Remote Shooting
Allows you to operate the camera shutter from the computer (p. 72).

View Images
Displays the selected image in the Viewer Window.

SlideShow

Starts a slide show of the selected images. Click the [View] menu and select [Slide Show
Options] to set the slide show settings.

Internet
Create Images for Email
Converts the selected images to the appropriate size for transmission by e-mail. You can also
use it to automatically start an e-mail program after conversion.
Print
Layout Printing
Allows you to arrange the selected images in an attractive layout and print them (p. 55).

Index Printing
Prints the selected images as an index.

Send to Trash

Sends the selected images or folders to the Trash.
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Functions Selected from Menus

Search Images: [File] menu, [Search]
Searches images by criteria such as Star Rating, dates, keywords, comments.

Export Images: [File] menu, [Export Images]

e Edit and Save: allows you to change the file type or size and export the file.

e Export Shooting Properties: allows you to export the shooting properties as a text file.
eExport as a Screensaver: Exports the image as a screen saver file.

eExport an Image as Wallpaper: Exports the image as a wallpaper file.

Organize Images: [File] menu, [Organize Image]

eSort Images: sorts images according to criteria such as the shooting date and time or Star
Rating and saves them into a specified folder.

eRename: changes the files names of multiple images in a single pass.

Convert RAW Images: [File] menu, [RAW image processing]

Converts RAW images. You can adjust the image brightness, contrast and color balance
among other attributes during conversion (p. 70).

Merge Panoramas: [Edit] menu, [PhotoStitch]
Merges multiple images and creates a single large panoramic image (p. 75).

Edit Movies: [Edit] menu, [Movie Edit]

Edits movies or still images strung together. You can add titles or background music and
apply various effects (p. 69).

Display Settings: [View] menu, [View Settings]

Hides or shows image information beneath the thumbnail, such as the file name or the
shooting date and time.

Sort Images: [View] menu, [Sort]

Arranges image order in the Browser Area according to criteria such as the filename, file
modification date, file size or shooting date.
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Checking Images before Downloading

Checking Images before Downloading

You can display camera or memory card images in the Camera Browser Window to view them
before downloading.

T rerform Step 1 in the Camera to Computer Connection section (p. 51) or steps 1-2
in the Memory Card Connection section (p. 53).
The Camera Control Window will display.

2 click [Lets you select and download 000 Canon XKXKXXXXXX
images].

{ Acquire Images | Setto Camera = Remote shooting

Starts to download images

Lets you select and download images

The images in the camera or memory card will display in the Camera Browser Window as
thumbnails (tiny images).

ana Camera Window - Canon X00000000C
B Domnioud images Large e m& 0
- T —— Camera Browser
! : 3 ~fright.  RGB Window
| - Thumbnail
4 -] & |_ WM SEN

Detailed Infarmation

oo [fest
o

TV Shatter Speed
1160

MC_000%5 JBG

3 select images to download.

To select multiple images, click on the first image and then hold down the [shift] or [§§ ]
(command) key while clicking on successive images.
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4 Click [Download images]. [aYa) Camera Window - Canon XXX
[ Download Images ] ‘ ﬁ“ Large Bﬁ = ‘ ‘ B ‘ t
2 3

IMG_0002 JPG IMG_0003.)PC

5 Confirm the destination folder and click Cnsranaos - Dosndoad knaoss
[Start Download]. File name Serings

Do not medify 1]
Fibe Prefix

Specify the file name for saved images.

Assign Sequence Mo,
Humber of

St R

Example:

{ KA Brention fype of image file is unchanged, )

Specify the destination folder for the
images.

You can change the destination folder by
clicking [Browse] and selecting a new
destination.

¥ Creata Sub folder
Shonting YearonthDate - B
Select [Create subfolder] to create a new N ame

folder within the one specified above, and
select a naming option.

Save o= (Foldar Mama)

B anther-UsersooORRCrures

[ Browse.

Example: [ O¥-Panther:Lsess 000 Pctures

(1 2003.12.31

S

(_ cancel ( ( sunDowniosd )

The thumbnails of the downloaded images will display in the Browser Window of
ImageBrowser when downloading is complete.

You can also download images to the computer by dragging images displayed in
the Camera Browser Window and dropping them onto the Browser Area or
Explorer Panel in ImageBrowser.

Other Downloading Methods

Your digital camera employs a standard image transfer protocol called Picture Transfer
Protocol (PTP). With PTP, you can use the programs supplied as standard software with
Mac OS X, such as iPhoto or Image Capture, to download images simply by connecting
the camera to the computer with the interface cable. (ImageBrowser does not need to
be installed.) However, there are some inconveniences and limitations to this
downloading method. See the leaflet entitled For Windows® XP and Mac OS X Users
for details.
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Repluymg Movies

Double-click an image with a movie icon in ImageBrowser’s Browser Area.

The movie will appear in the Viewer
Window. ____'m

Movie icon

2 Click the [Play] T button. ena 234040
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Editing Movies

You can create and edit movies: link movies and stills that have been downloaded to your
computer, add background music, superimpose titles and other text, and apply various effects
to the movies.

1 selectthe image(s) to edit in ImageBrowser’s Browser Area (movies or stills).
You can select multiple movies or stills.

2 Click the [Edit] menu and select [Movie Edit].

3 Follow the steps displayed in the middle of the window to edit the movie and save
it.

— Follow these steps
to proceed.

‘a6 MavieEdit Task

ArTanga images.
1. To arrangs images, sebect 1he image and click on the [Move Let] or [Hove Righ] burton
2 €k he [Fiay Gumion 16 playthe aranged eifacts and check tham

3. Click the |EMact] 130 1 g0 to EMect Step

Instructions

- P ‘ (7 1) Click this button
e for detailed
operational

instructions.

=)

Play Time 0:05.1

&

— Click this button Storyboard Area Transition Effect Box
to play the movie Displays thumbnails of the Appears between adjacent
being edited. selected images. images and displays the
Links images in order from symbols of the transition

left to right. effects linking images.
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Converting RAW Images

RAW images are extremely high-quality images that are not subject to any deterioration due to
compression processing. Since they are a special type of image, they cannot be opened by
many image editing programs. It is first necessary to convert them into standard image files.

e See Information about Your Camera (p. 94) to determine whether your
camera model supports this function.

*See the Camera User Guide for information about the camera settings for
shooting RAW images.

Procedures for Converting RAW Images

1 selectarAwW image in ImageBrowser’s Browser Area.
2 Click the [File] menu and select [RAW Image Processing].
The main window, the Navigator window

and the Image Quality Adjustment Window Main Window
will display.

80 Ll RAW Image Task
Use the buttons here to switch between j— [ A W 7 Swve 3 b

images and display modes, rotate images, =

] @ -] =3 i LR
. i " o
and set the conversion parameters.

Thumbnail

Check Mark

If the navigator window does not display, click the [View] menu and
select [Show Navigator].

3 Adjust the image quality as required in the Image Quality Adjustment Window.

This window is explained in the Functions of the Image Quality Adjustment Window
section.



4 Click the [2. Save] tab, set the file type  eon

and destination, and then click [Savel].

Select [All Images] or [Checked Images]
(images checked in the main window) to
apply the common conversion settings.

Select a file type

Comwrsion Target
0 g,

Convern from AW to Oher Format
File Formar
Comprriiion katia

Ruscistion

save fbdar
) S i il g foker.
S i falkowing specited foider

Set the file destination

Rename File
0 o Moy
et Tet

You can also change the file name

This will convert the image.

Aasign Sequasce No.
St 58 Doy

Shart Mgty

5 Click the [3. Exit] tab and click [OK].

Functions of the Image Quality Adjustment Window

i

AW image Tuik

st TIFFIBch) 1)

ED piasieh  (10-2001

o

=

The following adjustments can be made in the Image Quality Adjustment Window. The
available settings may vary depending on the camera used.

This section adjusts the
white balance according

Q © O Image Quality Adjustmef

to the light source and
color temperature.

This section adjusts the
digital exposure
compensation, photo
effect, contrast,
sharpness, and saturation.

The effect of the settings
above can be viewed
immediately if you place a
check mark here.

Restores all settings to the
settings stored in the
camera at the time of
shooting.

Camera type:  XXXXXXXXXKKK
(“White Balance \
(Auto k)
Color temperature
= 5200 K
4 12000-10000
Magenta Creen
—e -
\ L0100/
( Digital Exposure Compensation )
[
(-2.0-+2.0)
Phata Effect
off B
Cantrast
1]
(-5-4+5)
Sharpness
7
n-10y
Saturation
1]
\_ (-5-+5) Y,
M Preview

Reset Apply

Tone Curve Tab

You can set the levels for
the RGB channels
separately or together.

Advanced Adjustments
Tab

You can set the settings
for adaptive noise
control and the color
space for the output.
Click the arrow to
display the tab.

| If you cannot set the

desired setting with the
slider on the left,
directly enter the setting
here.

Applies the settings to
the displayed image

Gl

You can change the coloration of the image to your preferred settings when
you convert a RAW image. You can also select preset color schemes, such as
Positive Film. Furthermore, you can add your own color schemes (My Color) to
apply to other RAW images when they are being converted. See the PDF
manual for ImageBrowser for more information (p. 2).
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Operating the Shutter Remotely

Operating the Shutter Remotely

You can record still images by using a computer to control the shutter of a connected camera.
This is particularly useful for checking images on the larger display of the computer as you
record them and for high volume photography without worrying about filling the camera’s
memory card.

Preparing for Remote Shooting

1 Attach the supplied interface cable to the computer's USB port and the camera's
DIGITAL terminal and place the camera in the correct mode for connecting.

e Procedures for attaching the camera to the computer and placing it in
the correct mode for connecting vary between camera models. See
Information about Your Camera (p. 94).

e Perform the settings described in ImageBrowser Auto Start Settings
(p. 51) the first time you connect the camera to the computer.

The Camera Control Window will display.

2 Open the lens cover or remove the lens cap on models equipped with them.
Proceed to the next step if your model does not have one.

3 Click the [Remote shooting] tab. 080 Canon XXXXKXXXX

[ Acquire Images ~ Set to Camefla | Remote shooting }

i ; Starts Remote Shooting

Preferences ( Quit ]

4 cick [Starts Remote Shooting].

5 Select a destination for the captured images and click [Choose].
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RemoteCapture Task Window

The RemoteCapture Task window has the following features.

Shows/Hides the
viewfinder or
detailed settings

Size and Resolution Selector
Selects the size and resolution at which
images are captured.

Rotation Settings
Sets the rotation

area.

You can add
comments to images
by placing a check
mark here and
typing text in the
boxes below.

Viewfinder Display
Click the [Start/Stop
Viewfinder] button
while a connection to
the camera is open to
display the image
appearing in the
camera'’s viewfinder.

8een RemoteCapture Tas
v:Hide Viewfinder @ \@ Release Parameters for
¥ Hide shooting details ,i;-‘j 0 i Images after they are

captured.

] Add comments shown below

Release Button
Releases the
shutter.

e

Slide this to zoom
the camera in or out.

Start/Stop Viewfinder
" = Button
&3

Starts or stops the
viewfinder display.

Field angle __shooting settings |
Focusing Point: Flash:
Manual selectio... |3 [ Off B Refresh Button
Macro: FlashQuality: Resets the exposure,
oif = ' focus and white
AF-assist light: balance.
AF operation:
AF unlock e

Set the basic camera settings here.

e The settings available in the RemoteCapture Task window vary between
camera models.

* RemoteCapture Task locks the exposure and focus settings for the subject
matter in the Viewfinder section. If the lighting or distance to the subject
changes, click (B2 to reset these settings.

Gl
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Operating the Shutter Remotely
Remote Shooting

Ensure that you turn off your computer’s sleep mode before you begin remote
shooting. The device performance cannot be guaranteed if the computer
enters the sleep mode.

Click and check the subject in the viewfinder.

Change the image size or resolution, the rotation settings and the settings at the
bottom of the window as required.

If you intend to hold the camera vertically to photograph a subject, you can save the
image to the computer with the correct orientation if you set the rotation settings in
advance.

N) =i

If your camera is equipped with the Auto Rotate function and you set it
to On, the image will automatically be rotated and appear in the correct
viewing orientation in the RemoteCapture Task window.

3 Click the [Release] button.

*You can release the shutter by pressing the camera’s shutter button or
the keyboard’s space key.

e Other than the shutter button, the camera's buttons and switches,
including the zoom, cannot be operated while the camera is being
controlled with the Remote Shooting function.

¢ You may notice that the interval between the shutter release and
activation is slightly longer for remote shooting than when the camera
is used independently.
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Merging Panoramic Images - PhotoStitch

You can create a wide panoramic image by merging several images. It is easier to merge
images if they are shot with the camera's Stitch Assist mode because PhotoStitch can
automatically detect the image order and orientation.

Images Shot in Stitch Assist Mode

A sequence of images shot in Stitch Assist mode is saved into a single folder when it is
downloaded from the camera. In addition, the symbol below displays by the image in the
Browser Area.

Symbol displayed by images shot in Stitch Assist )
mode. _lij

e See the Camera User Guide for information about shooting in
Stitch Assist mode.
eImages shot in Stitch Assist mode with a wide converter,
teleconverter or close-up lens cannot be merged accurately.

Starting PhotoStitch

1 select a series of images in the ImageBrowser’s Browser Area.

Click the [Edit] menu and select enn. ol thesssinch
[PhotoStitch]. .

Instructions

STA_BTS3JPG | STELSTS4.MPG STL_B7E5.JPG

P e 3 2802 % 1944 Tron Cotor

3 Merge the images following the
instructions in the guidance panel at the top of the PhotoStitch window.
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Enjoy Customizing Your Camera with the My
Camera Settings

The start-up image, start-up sound, shutter sound, operation sound, and self-timer sound are
called the My Camera settings. You can add your favorite images and sounds from your
computer to the My Camera settings. This topic explains how to upload the My Camera
settings saved onto your computer to the camera and vice versa.

Displaying the My Camera Window

1 Attach the supplied interface cable to the computer's USB port and the camera's
DIGITAL terminal and place the camera in the correct mode for connecting.

e Procedures for attaching the camera to the computer and placing it in
the correct mode for connecting vary between camera models. See
Information about Your Camera section (p. 94).

e Perform the settings described in ImageBrowser Auto Start Settings
(p. 51) the first time you connect the camera to the computer.

The Camera Control Window will display.

2 Click the [Set to Camera] tab. ne0 Canon XXXXXXXXXX

( ) :
" Acquire Imag§s | Setto Camera | femote shooting |
—

. || set My Camera
|

Set Slide Show /DPOF

Confirms/changes camera settings

& €

It

4= | Uploads images to the camera

L

Preferences.. |¢/\

3 Click [Set My Cameral.
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The My Camera Window

ImageBrowser already contains several pre-recorded My Camera settings items. You can check
these items with the My Camera window.

Type Sav
. — Save to Camera
Select the settings type. _Save to Computer Play Button
P Plays the audio from
the settings file in the
. . camera.
Displays the list
of settings files My Camera .
saved onto the Type{ Theme 13 Dlsplays _the
computer. amera (Only editablg items dispa) settings in the
camera.
= B
o Py ') ( oeme = Delete Button
o Deletes a settings
masen file from the
Add Button \ nd to Trash camera.
Adds the settings ¢ my
file to the list. Save To:§SX-Panther-Users XXX Library Preferences-ImageBrowserUserData:
MyCamegaFiles
Play Button — | SDertto Tra.:!:. BUt’::_)In Save to Camera Button
Plays the audio from the ¢ ele e}s\ <S5y mgts = Click here to save the
selected settings file. romgihe compurter. :::;‘]'ggs onto the

You can add new files as My Camera settings to the My Camera window. See
Adding New Data to the My Camera Window (p. 79).
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Saving the My Camera Settings to the Camera

Iﬁl e My Camera settings can be selected and saved in either of two ways to the

camera: individually or in theme sets.

*The “Animal” theme, for example, features an animal in the start-up image
and animal calls in each of the sound files. The names of the prepared files
for the various My Camera settings themes all begin with the same root
name. The start-up image and sound files in the "Animal" theme, for
example, all begin with “Animal~".

0 Do not detach the interface cable, turn the camera power off or disconnect

the camera from the computer while the My Camera settings are being saved
to the camera or the settings from the camera are being saved to the
computer.

Select the type of setting in the Type list box that you wish to save to the camera.
Select the setting from the Computer list that you would like to add.

Select the setting in the Camera list that you would like to change and click the
button.

The Camera list setting will change to the selected file. If a setting for this category has
previously been saved to the camera, it will be overwritten.
Repeat steps 1-3 as required.

W=

4 Click the [Save to Camera] button.

This concludes the process of saving the My Camera settings to the camera.
To use this data on the camera, change the start-up image and sound settings on the
camera itself. Please see the Camera User Guide for these instructions.

Saving the Camera’s My Camera Settings to the Computer

Select the type of setting you wish to save to the computer from the Type list box.
Select the setting in the Camera list that you wish to save to the computer.

Click the [= button.

Input a file name to the selected setting and click the [OK] button.

This concludes the process of saving the My Camera settings to the computer.
Repeat steps 1-4 as required.

RN =
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Adding New Data to the My Camera Window

Create a new image or sound file and add it to the My Camera window.

Create an Original Start-up Image File and then Add It

Start by using an image editing program to create the image file that will become the start-up
image and save it to the computer. Create a JPEG image at a size of (w) 320 x (h) 240 pixels.

1 Open the My Camera window, select [Start-up Image] from the Type list box.

2 Click the [Add] button. ANIMALD23
B . BARZ21
3 select the file you created and click BASERALLZ L <
[Openl. 3
This concludes the process for adding new £——Add—) | Sendto Trash ) |
data. ( —
YOU can Sa,ve the nery Created data tO the Save To:0SX-Panther:Users:XXXX:Library:Preferences:ImageBrows
camera using the procedures described in MyCameraFiles:
the Saving the My Camera Settings to the Save tc

Camera section (p. 78).

Add an Original Sound File

Change the file to a WAV sound file after you have copied the sound file to the computer.
Then proceed with the steps as described in Create an Original Start-up Image File and then
Add It.

e Record the sound as an 11.025 kHz or 8.000 kHz, 8 bit, mono sound in
the WAV format.
*The following chart shows standard time lengths for My Camera Sounds.

Duration in Seconds
Type
11.025 kHz 8.000 kHz
Start-Up Sound 1.0 sec. or less 1.3 sec. or less
Shutter Sound 0.3 sec. or less 0.4 sec. or less
Operation Sound 0.3 sec. or less 0.4 sec. or less
Self-Timer Sound 2.0 sec. or less 2.0 sec. or less




This chapter introduces the CD-ROM supplied with your camera and the procedures for
installing the programs. It also explains how to uninstall the programs.

Read the Troubleshooting section in this chapter if you experience a problem using the
programs.

ArcSoft PhotoStudio

ArcSoft PhotoStudio is a high-performance yet easy-to-use image editing program from
ArcSoft, Inc. It can process, edit and print images. It includes color corrections, brightness
adjustments and special effects. Install it from the supplied CD-ROM, the Canon Digital Camera
Solution Disk, as required.

Installing ArcSoft PhotoStudio

Windows

1 Ccloseall programs that are running.

2 Place the Canon Digital Camera Solution Disk in the CD-ROM drive.
If the installer panel displays, click [Exit] to close it.

3 Click the [Start] menu, and select [My Computer]. Windows 2000, Windows Me
and Windows 98 users, double-click the [My Computer] icon on the desktop.

4 Right-click the CD-ROM icon and select [Open].

5 Double-click the [ARCSOFT] folder or right-click it and select [Open], and double-

click the [SETUP.EXE] icon E¥.
Follow the onscreen messages to proceed with the installation.

Macintosh

1 Closeall programs that are running.
2 Place the Canon Digital Camera Solution Disk in the CD-ROM drive.

3 Open the CD-ROM and double-click [ARCSOFT], followed by the [PhotoStudio
Installer] icon [#.

Follow the onscreen messages to proceed with the installation.

4 ciick [OK] when a message appears stating that the installation is complete.
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Starting ArcSoft PhotoStudio

You can start ArcSoft PhotoStudio from within ZoomBrowser EX (Windows) or ImageBrowser
(Macintosh).

ZoomBrowser EX

Click [Edit] in the Task Area of the Main Window, followed by [Edit Image].
Click [1. Select Images] and select an image to edit.

Click [2. Select Editing Tool] and select [Edit with external image editor].
Select ArcSoft PhotoStudio from the program list and click [3. Finish].

BN =

If you cannot select ArcSoft PhotoStudio, register the program using the
following procedures.
1.1n Step 3 above, select [Edit with external image editor] and click
[Manage List].
2.Click [Add] and select [ArcSoft PhotoStudio].

ImageBrowser
T selectan image to edit, click the [Edit] menu and select [ArcSoft PhotoStudio].

Manual for ArcSoft PhotoStudio

You can obtain the ArcSoft PhotoStudio manual from the ArcSoft, Inc., website. Use your
browser program to download the manual from the following URL:
http://www.arcsoft.com/support
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| Uninstalling the Software

Uninstalling the Software

The procedures for uninstalling the software are only required when you wish to delete the
programs from your computer or when reinstallation is required to fix corrupted files.

Uninstalling the Software (Windows)

Software Installed from the Canon Digital Camera Solution Disk (excluding
ArcSoft PhotoStudio)

This explanation uses ZoomBrowser EX to demonstrate how to uninstall a program.

1 Click the Windows [Start] menu and
select [Programs] or [All Programs],
followed by [Canon Utilities],
[ZoomBrowser EX] and [ZoomBrowser
EX Uninstall].

BesCoooooooood
FoEow 4 s v A
53 i ]

The uninstall utility will start and remove
ZoomBrowser EX.

*You can remove other programs with the same procedures.
*To uninstall CameraWindow, be sure to follow the following
procedures.

1. Click the [Start] menu and select [Programs] or [All Programs],
followed by [Canon Utilities], [CameraWindow], [PowerShot - IXY-
IXUS - DV] and [CameraWindow Uninstall].

2. Click the [Start] menu and select [Programs] or [All Programs],
followed by [Canon Utilities], [CameraWindow], [EOS Digital] and
[CameraWindow Uninstall].

3. Click the [Start] menu and select [Programs] or [All Programs],
followed by [Canon Utilities], [CameraWindow] and [CameraWindow
Uninstall].

¢ PhotoRecord can be uninstalled by clicking the Windows [Start] menu
and selecting [Programs] or [All Programs], followed by [Canon

PhotoRecord] and [PhotoRecord Uninstall].

Uninstalling ArcSoft PhotoStudio

ArcSoft Camera Suite 2.1, ArcSoft Camera Suite 1.3
e Uninstall the program by clicking the [Start] menu and selecting [Control Panel] and [Add or

Remove Programs].
¢ With Windows 2000/Me/98, uninstall the program by clicking the [Start] menu and selecting
[Settings] followed by [Control Panel] and [Add/Remove Programs].
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Uninstalling the USB Driver (Windows)

Uninstall the USB Driver using the following procedures if you are using Windows 2000,
Windows Me or Windows 98 SE.

0 It is essential to note that you will not be able to download images if you
uninstall the USB driver.

Iﬁl You do not need to uninstall the USB driver with Windows XP.

1 Attach the supplied interface cable to the computer’s USB port and the camera’s
DIGITAL Terminal. Prepare the camera for communication with the computer.

For interface cable connection instructions, see Information about Your Camera (p. 94).

2 Click the [Finish] button if the Camera Control Window displays.

3 Click the [Start] menu and select
[Settings], followed by [Control Panel].

»
Printers
M Taskbar & Start Menu, ..

g Shut Down...
Rstart H & 50 “

4 Double-click the [Scanners and

Cameras] icon or folder. DBk Ve Pt Todh teb
|>1-r - = - | Piseac rodes (3 W G X o | [
Address | ] Cortrol Panel
ey B § B @ W
Aocessblty  AddRemove AddRemave Adnnstrste  Adorets [
Control Panel Cptiin Hwdwae  Proge Tewks Upsdates
Use the ssktings i Cortrel Panel to —@f ] “f!; L
s B @ 4 % 9
Seleck 30 ke ta wiew ks description. Options options
" s - oy 3 -
> =@ @ 39
Mersic Metverk ol Phoneg ared  Powwer Opliong Prirdors

fnchind  Sourdiand  Symen Uueecand
Manmads Paspeds
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5 Delete your camera model name or i
[Canon Camera] in the [Scanners and

Cameras Properties] dialog.
Windows Me users should delete their
camera model or [Canon Camera] in the allsadaguggrres or cameras ane nstaled:
[Scanners and Cameras] folder.

Davices |

Add.. ( Femove
L5

Troubleshoat Praperties

Windows 2000
Select your camera model name or [Canon Camera] and click [Remove].

Windows Me
Select your camera model name or [Canon Camera], right-click the mouse and select
[Delete].

Windows 98 SE
Select your camera model name or [Canon Camera] and click [Remove]. Then turn off the
camera and remove the interface cable from the computer's USB port.

If your camera model name e th mera not
detected, Events dialog ] ot download to the
computer (p. 87) of

6 Click the Windows [Start] menu and select [Programs] or [All Programs], followed
by [Canon Utilities], [Camera TWAIN Driver x.x] and [Uninstall TWAIN Driver]. A
version number appears in place of the “x.x".

e Windows 2000, Windows 98 SE: Perform Step 6 with no substitutions.
e Windows Me: Substitute the following for the underlined portions of Step 6.
[Camera WIA Driver x.x], [Uninstall WIA Driver]

The uninstall process will start.

To connect the camera to the computer and download after this point, use the following
procedures.

1. Reinstall the driver.

2. Connect the camera to the computer with the interface cable.

Uninstalling the Software (Macintosh)

Uninstall the programs by dragging the application’s folder (the folder in which it was installed)
into the Trash, and then empty the Trash.

Please be careful not to accidentally delete any folders with downloaded
images that may be contained within the application folder.
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Memory Card Folder Structure

The images on a memory card are placed in the [DCIM] folder in subfolders labeled
[xxxCANON], where the “xxx” represents a number in the range 100 - 998.

—— IMG_xxxx.JPG (JPEG images)
EI T — _MG_xxxx.JPG (JPEG images recorded in the

DCIM Adobe RGB color space)
xxxCANON —— CRW_xxxx.CRW (RAW images)
—— _RW_xxxx.CRW (RAW images recorded in the

Adobe RGB color space)
—— CRW_xxxx.THM*
—— STx_xxxx.JPG** (Stitch Assist mode images)
—— MVI_xxxx.AVI (Movies)
—— MVI_xxxx.THM*
—— SND_xxxx.WAYV (Sound annotation)

The folder that holds the settings files for
images in the DCIM folder.

CANONMSC

The folder created when DPOF settings are set.
It holds the DPOF settings files.

MISC

¢ *Files with the THM extension are the thumbnail image files for the camera’s index replay
mode.

*The “xxxx" in file names represent four-digit numbers.

e **Each successive file shot in Stitch Assist mode is assigned a letter starting from “A,” which
is inserted as the third digit in the name. i.e. [STA_0001.JPG], [STB_0002.JPG],
[STC_0003.JPG]...

o All folders except the “xxxCANON" folders contain image settings files. Do not open or delete
them.
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Troubleshooting

Troubleshooting

Please read this section if you encounter a problem using the software.

Start by Checking This

Investigate the following points first if you encounter a problem.

@ Does your computer satisfy the requirements listed in the System
g Requirements section (p. 8)?

? Is the camera correctly connected to the computer?

See Information about Your Camera (p. 94) for the correct connection
procedures. Also check to ensure that you are using the correct cable and
that it is securely attached at both ends.

@ Is the camera set to the playback mode? (some models only)
Q

Some models require the camera to be set to the playback mode to
transfer data. See Information about Your Camera (p. 94) for details.

? Is the battery sufficiently charged?

Check the battery charge if you are powering the camera with a battery.
You are recommended to use a household power source (AC adapter) to
power the camera when it is connected to a computer (if available for
your camera model).

Problems

Try the suggested solutions to the common problems listed below.

? USB driver installation not proceeding well (Windows)

Uninstall the driver (p. 83) before reinstalling it with the procedures in Installing
the Software and USB Driver (p. 10).
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?

Q

Add New Hardware Wizard or New Hardware Found (Windows 2000)
Wizard displays when the camera is connected to the computer with an
interface cable.

Click [Cancel] to close the window. Temporarily disconnect the camera from the
computer. Next, read Start by Checking This on the previous page and resolve
the problem.

Images won't download into a TWAIN-compliant program (Camera and
computer connected via interface cable (Windows 2000, Windows 98 SE)).

Click the [Finish] button in the Camera Control Window to close it.

Camera not detected, Events dialog won’t display or images will not
download to the computer (when camera is connected to the computer
via an interface cable).

Cause 1:

There is a problem with one of the items in the Start by Checking This
section (p. 86).

Solution:
Resolve the problem.

Cause 2:
The USB driver is not installed (Windows only).

Solution:
Install it with the procedures in Installing the Software and USB Driver (p. 10).

Cause 3:

The USB driver is not correctly installed (Windows only).

Solution:
Uninstall the driver (p. 83) before reinstalling it with the procedures in Installing
the Software and USB Driver (p. 10).

Cause 4:

The camera may have been recognized as another device under the

following circumstances (Windows only).

e The camera was connected to the computer before the USB driver was
installed.

e The [Scanners and Cameras] icon or the [Scanners and Cameras] folder cannot
be found in the [Control Panel] or the [Printers and Other Hardware] window.

e Your camera model name, [Canon Camera] or a camera icon does not display
in the [Scanners and Cameras Properties] dialog or the [Scanners and
Cameras] folder.
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Solution 1:

Start with the following procedures.

Install the USB driver with the procedures in Installing the Software and USB
Driver (p. 10). Then connect the camera to the computer with the interface
cable and prepare it to transfer data. If the USB driver is already installed,
uninstall it first and then reinstall it.

Solution 2:

If the problem is not resolved with the procedures in Solution 1, continue by

implementing the following procedures. The specific steps are explained below.

1. Check to see if the camera is being recognized as an “other” device.

2. Delete the driver and the setup information files if it is being recognized as an
“other” device.

3. Reinstall the driver.

This section explains the specific steps for each operating system.

Windows XP and Windows 2000

Users of Windows XP and Windows 2000 mu gin asan
Administrator (computer system adminis ete a driver.

Check to see if the camera is being recognized as an “other” device and
delete the driver if it is.

1. Windows XP: Click the [Start] menu, followed by [Control Panel],
[Performance and Maintenance] and [System].
Windows 2000: Click the [Start] menu and select [Settings] and [Control
Panel]. Double-click the [System] icon.

. Click the [Hardware] tab, followed by [Device Manager].

. Click the [#] symbol beside the [Other devices] and/or [Imaging devices]
category. Your camera model name or [Canon Camera] will display in these
categories if it is being recognized as an “other” device.
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There are other potential reasons for the problem if the “Other devices”
or “Imaging devices” categories do not appear or your camera model
name or [Canon Camera] does not appear. Proceed to Step 6,
temporarily quit the procedures and investigate the other potential
causes.
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4. Select your camera model name or [Canon Camera], right-click and select
[Delete].

5. Click [OK] in the confirmation dialog.
Delete all instances of your camera model name or [Canon Camera] if it
appears in one or more places in the [Other devices] or [Imaging devices]
categories.

6. Close the System Properties window.

Iﬁl Step 7 and above are not required for Windows XP.

Delete the setup information files

7. Double-click the [My Computer] icon on the desktop, followed by the [C:]
drive, [WINNT] folder and [Inf] folder.

If the [Inf] Folder Is Not Visible in the [WINNT] Folder
Use the following procedures to show all files and folders.

. Open the [WINNT] folder.

. Click the [Tools] menu and select [Folder Options].

. Click the [View] tab.

. In the [Files and Folders] category in the Advanced Settings section, set [Hidden files
and folders] to [Show hidden files and folders]. Remove the check marks from [Hide
file extensions for known file types] if it is present.

5. Click [OK] to close the dialog.
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This will make the hidden files and folders visible.
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8. Look for files for Canon digital cameras that start with [CAP*].
The "*" represents a number, such as 0 or 1.
[CAP*] files come in pairs of [CAP*.inf] and [CAP*.pnf] files (For example,
[CAPO.inf] and [CAPOQ.pnf]).
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9. Double-click the [CAP*] files to check their contents.
Double-clicking an [CAP*.inf] file will open it in the Windows Notepad
program. Look for [;****Canon Camera Driver Setup File****] in the first
line. Note down the names of these files.

Several sets of [CAP*] files may be present in the [Inf] folder. Open up
each file to confirm that it is an [CAP*] file for Canon digital cameras
before you do anything with the file.

10.Delete the [CAP*] file set.
Delete the [CAP*.inf] and [CAP*.pnf] file for Canon digital cameras that you
noted down in Step 9.

The Inf folder contains numerous files critical to the computer’s
operation. Be extremely careful to delete the correct files. If you delete
the wrong files, you may be unable to restart Windows.

Reinstall the driver.

11.Reinstall the driver with the procedures in Installing the Software and USB
Driver (p. 10).

Windows Me/Windows 98 SE

Check to see if the camera is being recognized as an “other” device and
delete the driver if it is.

1. Click the [Start] menu and select [Settings], followed by [Control Panel].
Double-click the [System] icon.
This will display the System Properties window.

2. Click the [Device Manager] tab.

3. Click the [#] symbol beside the [Other devices] and/or [Imaging devices]
category. Your camera model name or [Canon Camera] will display in these
categories if it is being recognized as an “other” device.




or “Imaging devices” categories do not appear or your camera model
name or [Canon Camera] does not appear. Proceed to Step 6,
temporarily quit the procedures and investigate the other potential
causes.

Iﬁl There are other potential reasons for the problem if the “Other devices”

[SalFAN

6.

. Select your camera model name or [Canon Camera] and click [Remove].
. Click [OK] in the confirmation dialog.

Delete all instances of your camera model name or [Canon Camera] if it
appears in one or more places in the [Other devices] or [Imaging devices]
categories.

Click [OK] to close the System Properties window.

Delete the setup information files.

7.

Double-click the [My Computer] icon on the desktop, followed by the [C:]
drive, [Windows] folder and [Inf] folder.

1.

2.
3.

4.

If the [Inf] Folder Is Not Visible in the [Windows] Folder
Use the following procedures to show all files and folders.

Windows 98 SE: Click the [View] menu and select [Folder Options].

Windows Me: Click the [Tools] menu and select [Folder Options].

Click the [View] tab.

Windows 98 SE: Set the [Hide files] section to [Show all files].

Windows Me: Set the [Hidden files and folders] section to [Show hidden files and
folders].

Click [OK] to close the dialog.

This will make the hidden files and folders visible.
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8. Find and delete the [Drvdata.bin] and [Drvidx.bin] files.
9. In the [Inf] folder, double-click the [Other] folder to open it.
10. Find and delete the [Canon.IncCAP_xxx.Inf] file (The xxx
represents numerals.).

You do not need to delete anything if none of the above files are
contained in the [Other] folder.

The [Inf] folder contains numerous files critical to the computer’s
operation. Be extremely careful to delete the correct files. If you delete
the wrong files, you may be unable to restart Windows.

Reinstall the driver

11.Reinstall the driver with the procedures in Installing the Software and USB
Driver (p. 10).

Zooming Images in ZoomBrowser EX is Slow or Not Working

Some graphics cards or settings may cause the display of zoomed images in ZoomBrowser EX
to slow down or malfunction. If this occurs, set your computer display's Hardware acceleration
setting to a lower setting.

1. Click the Windows [Start] menu, followed by [Control Panel] and
[Appearance and Themes].
With Windows 2000, Windows Me, or Windows 98 SE, click the [Start] menu
and select [Settings], followed by [Control Panel].

2. Click the [Display] icon, followed by the [Settings] tab, [Advanced] button and
[Troubleshoot] tab.
With Windows 2000, click the [Display] icon, followed by the [Settings] tab,
[Advanced] button and [Troubleshoot] tab.
With Windows Me or Windows 98 SE, click the [Display] icon, followed by
the [Settings] tab, [Advanced] button and [Performance] tab.

3. Set the [Hardware acceleration] to a setting below [Full] and click [OK].

4. Restart the computer if prompted.
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If You Were Using ZoomBrowser EX Version 2 or 3

Take the following steps if you were using ZoomBrowser EX version 2 or 3 with Windows.

If Titles and Comments Were Attached to Your Images.
Take the following steps to display in version 5 the titles and comments you
input in version 2/3.

1. Use Windows Explorer to open the [Program] folder within the folder in
which you installed ZoomBrowser EX 5.
(e.g. C:\Program Files\Canon\ZoomBrowser EX\Program)

. Double-click [dbconverter.exe] found in this folder to start this utility.

. Select the database file you were using up to this point and click the [Start]
button.
(e.g. C:\Program Files\Canon\ZoomBrowser EX\Database\My Database.zbd)

w N

This will display the titles and comments input in the earlier versions in the
comments section of ZoomBrowser EX 5.

If You Had Images in a Folder Below the Program Files Folder

Image files in the [Program Files] folder or a subfolder cannot be displayed in
ZoomBrowser EX 5 from that location. To display these files, first perform steps
1-3 above and then carry on with Step 4.

4. Use Windows Explorer to copy the folder and the images it contains from the
[Program Files] folder to another folder.
(e.g. Copy the image folders in C:\Program Files\Canon\ZoomBrowser
EX\Library One to another location.)

The moved folder images can now be selected and displayed with
ZoomBrowser EX 5.



The software package and the procedures for connecting to a computer and preparing for data
transfers vary between camera models. Certain software functions may also not be supported
by some camera models.
Read this section to confirm the capabilities of your camera model.

Information Common to All Models

See the respective page for your camera model for information specific to that model (p. 94).

Programs and Compatible Operating Systems

The CD-ROM labeled “Canon Digital Camera Solution Disk” is provided with all models. It
contains the following programs.

Windows Programs

Compatible 05 | Windows | Windows | Windows | Windows Maior Functions

Program 98 Me 2000 XP !
*3 Downloading, displaying,

ZoomBrowser EX 1 g L o organizing and editing images

. *3 =4 | Driver for Canon brand cameras (for
TWAIN Driver ® _ o = | Windows 98, Windows 2000)
WIA Driver - o -_ —*4 | Driver (Windows Me)
PhotoRecord*1 o3 ) o @® |layout and printing
PhotoStitch*1 o3 ) ) @® | Mergingimages to make panoramas
ArcSoft PhotoStudio™ 1 *2 () ® (] @® |Advanced image editing

*1 Can be started from within ZoomBrowser EX.
*2 Image editing program manufactured by ArcSoft, Inc.

*3 Compatible with Windows 98 SE only.

*4 Driver not required because Windows XP supports PTP.

Macintosh Programs

Program N e MacOS 9 | Mac OS X Major Functions
ImageBrowser - o Downloading, displaying, organizing and editing images
PhotoStitch*1 - (] Merging images to make panoramas

ArcSoft PhotoStudio™1 *2 - ) Advanced image editing

*1  Can be started from within ImageBrowser.
*2  Image editing program manufactured by ArcSoft, Inc.
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Connecting the Camera to a Computer

Ensure that you have installed the software from the supplied Canon Digital
Camera Solution Disk before you connect the camera to the computer.

Item to Prepare

e Your camera and computer
e Canon Digital Camera Solution Disk
e Interface cable supplied with the camera

0 ¢ Use the interface cable to attach the camera directly to a USB port on the
computer, not through a USB hub. The connection may not operate correctly
through a USB hub.

*The connection may not operate correctly if you are using other USB devices,
excluding USB mice or keyboards, at the same time as the camera. If this
occurs, disconnect the other devices from the comp nd try reconnecting
the camera.

¢ Do not connect two or more cameras at the
via the USB interface. The connections

e Never allow the computer to go into
connected via the USB interface.
interface cable. Try to awake
connected state. Some co i isconnect
the camera while the
computer manual

e same computer
ctly.
ile a camera is

You are recommended to power the camera from a household power source
(AC adapter) when connecting to a computer (if available for your camera

model). Ensure that you use fully charged batteries if you will not be using a
household power source.

See the page (p. 94) for your specific model for information about connecting the camera to
the computer.



PowerShot A520/PowerShot A510

PowerShot A520/PowerShot A510

T Attach the supplied interface cable to the computer's USB port and the camera's
DIGITAL terminal.

Set the mode switch to Play and turn the camera power on.
The camera and computer will be set to the correct mode for communicating.

Non-Supported Programs and Features

The camera does not record RAW images.

9
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